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Notices

Federal Communications Commission Statement

This device complies with Part 15 of the FCC Rules. Operation is subject to the
following two conditions:

+  This device may not cause harmful interference, and

+  This device must accept any interference received including interference that
may cause undesired operation.

This equipment has been tested and found to comply with the limits for a Class

B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed

to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency energy
and, if not installed and used in accordance with manufacturer’s instructions, may
cause harmful interference to radio communications. However, there is no guarantee
that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined
by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

+ Reorient or relocate the receiving antenna.

+ Increase the separation between the equipment and receiver.

+  Connect the equipment to an outlet on a circuit different from that to which the
receiver is connected.

+ Consult the dealer or an experienced radio/TV technician for help.
/ ', \ The use of shielded cables for connection of the monitor to the graphics card is
\ required to assure compliance with FCC regulations. Changes or modifications

to this unit not expressly approved by the party responsible for compliance could
void the user’s authority to operate this equipment.

Canadian Department of Communications Statement

This digital apparatus does not exceed the Class B limits for radio noise emissions
from digital apparatus set out in the Radio Interference Regulations of the
Canadian Department of Communications.

This class B digital apparatus complies with Canadian ICES-003.

REACH

Complying with the REACH (Registration, Evaluation, Authorization, and Restriction
of Chemicals) regulatory framework, we publish the chemical substances in our
products at ASUS REACH website at http://csr.asus.com/english/REACH.htm.




Safety information

Electrical safety

To prevent electrical shock hazard, disconnect the power cable from the
electrical outlet before relocating the system.

When adding or removing devices to or from the system, ensure that the
power cables for the devices are unplugged before the signal cables are
connected. If possible, disconnect all power cables from the existing system
before you add a device.

Before connecting or removing signal cables from the motherboard, ensure
that all power cables are unplugged.

Seek professional assistance before using an adapter or extension cord.
These devices could interrupt the grounding circuit.

Make sure that your power supply is set to the correct voltage in your area.
If you are not sure about the voltage of the electrical outlet you are using,
contact your local power company.

If the power supply is broken, do not try to fix it by yourself. Contact a
qualified service technician or your retailer.

Operation safety

Before installing the motherboard and adding devices on it, carefully read all
the manuals that came with the package.

Before using the product, make sure all cables are correctly connected and the
power cables are not damaged. If you detect any damage, contact your dealer
immediately.

To avoid short circuits, keep paper clips, screws, and staples away from
connectors, slots, sockets and circuitry.

Avoid dust, humidity, and temperature extremes. Do not place the product in
any area where it may become wet.

Place the product on a stable surface.

If you encounter technical problems with the product, contact a qualified
service technician or your retailer.

crossed out wheeled bin indicates that the product (electrical and electronic

DO NOT throw the motherboard in municipal waste. This product has been
designed to enable proper reuse of parts and recycling. This symbol of the
|

equipment) should not be placed in municipal waste. Check local regulations for
disposal of electronic products.

DO NOT throw the mercury-containing button cell battery in municipal waste.
This symbol of the crossed out wheeled bin indicates that the battery should not
be placed in municipal waste.



About this guide

This user guide contains the information you need when installing and configuring
the motherboard.

How this guide is organized

This user guide contains the following parts:

Chapter 1: Product introduction

This chapter describes the features of the motherboard and the new
technologies it supports.

Chapter 2: Hardware information

This chapter lists the hardware setup procedures that you have to perform
when installing system components. It includes description of the switches,
jumpers, and connectors on the motherboard.

Chapter 3: Powering up

This chapter describes the power up sequence and ways of shutting down
the system.

Chapter 4: BIOS setup

This chapter tells how to change system settings through the BIOS Setup
menus. Detailed descriptions of the BIOS parameters are also provided.
Chapter 5: RAID configuration

This chapter provides instructions for setting up, creating, and configuring
RAID sets using the available utilities.

Chapter 6: Driver installation

This chapter provides instructions for installing the necessary drivers for
different system components.

Appendix: Reference information

This appendix includes additional information that you may refer to when
configuring the motherboard.

Where to find more information

Refer to the following sources for additional information and for product and
software updates.

1.

ASUS websites

The ASUS website provides updated information on ASUS hardware and
software products. Refer to the ASUS contact information.

Optional documentation

Your product package may include optional documentation, such as warranty
flyers, that may have been added by your dealer. These documents are not
part of the standard package.



Conventions used in this guide

To make sure that you perform certain tasks properly, take note of the following
symbols used throughout this manual.

' \ DANGER/WARNING: Information to prevent injury to yourself
g é when trying to complete a task.

' \ CAUTION: Information to prevent damage to the components
/ \

when trying to complete a task.

K IMPORTANT: Instructions that you MUST follow to complete a

task.

/ NOTE: Tips and additional information to help you complete a

task.

Typography

Bold text Indicates a menu or an item to select.

Italics Used to emphasize a word or a phrase.

<Key> Keys enclosed in the less-than and greater-
than sign means that you must press the
enclosed key.
Example: <Enter> means that you must press
the Enter or Return key.

<Key1+Key2+Key3> If you must press two or more keys
simultaneously, the key names are linked with
a plus sign (+).
Example: <Ctrl+Alt+Del>

Command Means that you must type the command

exactly as shown, then supply the required
item or value enclosed in brackets.

Example: At the DOS prompt, type the
command line: format A:/S

Xi



Z9NA-D6 series specifications summary

Model Name

Processor / System Bus

Core Logic
Form Factor

ASUS Features

Memory

Expansion Slots
(follow SSI
Location #)

Xii

FAN speed control

Rack Ready (Rack
and Pedestal dual
use)

Rack Optimized

(Dedicated for Rack)
ASWM Enterprise

Total Slots
Voltage
Capacity
Memory Type

Memory Size*

Total PCI/PCI-X/
PCI-E Slots

Slot Location 1
Slot Location 2
Slot Location 3
Slot Location 4
Slot Location 5
Slot Location 6
Slot Location 7

Additional Slot 1

| Z9NA-D6

| Z9NA-D6C
2*LGA 1356

Intel® Xeon® processor E5-2400 product family

QP16.4/7.2/8.0GT/s

Intel® C602-A PCH

12°x 9.9”

\

\

\Y

6 (3-channel per CPU, 3 DIMM per CPU)

1.5V/1.35V

Maximum up to 192GB

DDR3 800/1066/1333/1600 RDIMM
DDR3 1066/1333 ECC UDIMM/ Non-ECC UDIMM
DDR3 1066/1333 LR-DIMM

1GB, 2GB, 4GB, 8GB, 16GB, 32GB * (RDIMM)
1GB, 2GB, 4GB, 8GB * (UDIMM)
8 GB, 16GB, 32GB * (LRDIMM)

6

1* PCI-E5 x1 (X1 Gen2 Link), from C602 PCH; MIO supported

1* PCI-E4 x8 (X4 Gen2 Link), from C602 PCH

1* PCI-E3 x8 (X8 Gen3 Link), from CPU 2

1* PCI-E2 x8 (X8 Gen3 Link), from CPU 2

1* PCI-E1 x16 (X16 Gen3 Link), from CPU 1

1* PIKE Slot for Storage
expansion (Gen3 supported)

(continued on the next page)




Z9NA-D6 series specifications summary

Model Name | zoNa-D6 | zona-DeC

Storage SATA Controller Intel® C602-A: Intel® C602-A:
<AHCI> <AHCI>
4 SATA 3Gb/s ports; 2 SATA 4 SATA 3Gb/s ports; 2 SATA
6Gb/s ports 6Gb/s ports
Intel® RSTe (for Windows only) Intel® RSTe (for Windows
(Support software RAID 0, 1, 10 & | only)
5) (Support software RAID 0, 1,
LSI® MegaRAID (for Linux/ 10 & 5)
Windows)
(Support software RAID 0, 1, 10)
<SCU>
4 SATA 3Gb/s ports

Intel® RSTe (for Windows only)
(Support software RAID 0, 1, 10 &
5 for all SATA ports)

SAS Controller Optional kits: -
ASUS PIKE 2008 8-port SAS 6G
RAID card
ASUS PIKE 2008/IMR 8-port SAS
6G RAID card
ASUS PIKE 2108 8-port SAS 6G
HW RAID card
Networking LAN 2™ Intel 82574L
Graphic VGA Aspeed AST2300 with 16MB Aspeed AST1300 with 64MB
VRAM VRAM
Onboard /O TPM header 1
Connectors PSU Connector 24-pin ATX power connector + 8-pin ATX 12V
(Support Both ATX & SSI Power Supply)**
Device Power 4-pin power connector
Connector
Management Onboard socket for optional
Connector management card

USB Connectors 1* USB connector (Type A USB socket)
2 * USB pin header (up to 4 devices)

Fan Header 8 * 4pin

SMBus 2

Chassis Intruder

Front LAN LED

Serial Port Header

Rear /0 External Serial Port
Connectors External USB Port
VGA Port

_ D = A ==

PS/2 KB/Mouse

(continued on the next page)
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Z9NA-D6 series specifications summary

Model Name | zona-DeC
Management Software ASWM Enterprise

Solution ISR E | Optional ASMB6-IKVM for KVM-
Management over-Internet

Environment Operation temperature: 10°C ~ 35°C
Non operation temperature: -40°C ~ 70°C
Non operation humidity: 20% ~ 90% ( Non condensing)

*Refer to ASUS Server AVL for latest update.
** Minimum requirement of ATX Power supply:1) 470W 2) All +12V output = 20A
***Specifications are subject to change without notice.

Xiv



This chapter describes the motherboard
features and the new technologies it supports.

Product
introduction
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1.1 Welcome!
Thank you for buying an ASUS® Z9NA-D6 Series motherboard!

The motherboard delivers a host of new features and latest technologies, making it
another standout in the long line of ASUS quality motherboards!

Before you start installing the motherboard, and hardware devices on it, check the
items in your package with the list below.

1.2 Package contents
Check your motherboard package for the following items.

Z9NA-D6 Series

2 -

8 (ZONA-D6)
able 4 (Z9NA-D6C)

1 -

orie 1 1

1 1

1 1

Do entatio 1 1

gQ 1pc per carton 10pcs per carton

% If any of the above items is damaged or missing, contact your retailer.

Optional items Description

PIKE 2108 LSI 8-port SAS2 6G HW RAID card

PIKE 2008/IMR LSl 8-port SAS2 6G RAID card

PIKE 2008 LSI 8-port SAS2 6G RAID card

ASMB6-iKVM Remote management solution provides KVM over IP solution

ASUS Z9NA-D6 1-3



1-4

1.3 Serial number label

Before requesting support from the ASUS Technical Support team, you must take
note of the motherboard's serial number containing 12 characters xxS2xxxxxxxx
shown as the figure below. With the correct serial number of the product, ASUS

Technical Support team members can then offer a quicker and satisfying solution

to your problems.

XXS2XXXXXXXX

Chma

1.4 Special features
1.4.1 Product highlights

Latest Processor Technology

The motherboard supports the latest Intel Xeon® processor E5-2400 product family
in LGA 1356 package with integrated memory controller to support 3 channel (6
DIMM prt CPU) DDR3 memory. Intel Xeon® processor E5-2400 product family
supports Intel QuickPath Interconnect (QPI) with a system bus of up to 8.0GT/s.

Optimized Intel® Turbo Boost Technology

Optimized Intel® Turbo Boost Technology further optimizes the processor’s
performance and automatically allows it to run faster than the marked frequency if
it is operating below power, temperature, and current limits.

Intel® Hyper Threading

The thread-level parallelism on each processor makes more efficient use of the
processor resources, higher processing throughout and improved performance on
today's multi-threaded software.

Intel® EM64T

The motherboard supports Intel® processors with the Intel® EMB4T (Extended
Memory 64 Technology). The Intel® EMB4T feature allows your computer to run on
64-bit operating systems and access larger amounts of system memory for faster
and more efficient computing.

Chapter 1: Product introduction



DDR3 memory support

The Z9NA-D6 supports DDR3 memory that features data transfer rates of
1600/1333/1066 MHz to meet the higher bandwidth requirements of server

and workstation applications. The 3-channel DDRS3 architecture boosts system
performance, eliminating bottlenecks with peak bandwidth of up to 52GB/s. This
voltage reduction limits the power consumption and heat generation of DDR3
which makes it an ideal memory solution. Also, the motherboard can support LR-
DIMM (Load reduced DIMM) which uses a specially designed buffer to reduce the
data load to a single load and can increase overall server system memory capacity.

PCle 3.0

The motherboard supports the latest PCle 3.0 device, which doubles the delivered
bandwidth of PCle 2.0. This enhances system performance while still providing
backward compatibility to PCle 2.0.

Intel® 82574L Gigabit LAN Solution

This motherboard features the built-in dual server class Intel® Gigabit LAN ports,
which helps reduce CPU usage, thus increasing throughput to achieve highly-
reliable network connections, outstanding performance, and better support for
diverse operating systems.

Intel® 82574L chipset is VMware-certified to support the virtualization technology.

Enhanced Intel SpeedStep Technology (EIST)

The Enhanced Intel SpeedStep Technology (EIST) intelligently manages the
CPU resources by automatically adjusting the CPU voltage and core frequency
depending on the CPU loading and system speed or power requirement.

Serial ATA Il technology

The motherboard supports the Serial ATA Il 3 Gb/s technology through the Serial
ATA interface and Intel® C602 chipset. The Serial ATA Il specification provides
twice the bandwidth of the current Serial ATA products with a host of new
features, including Native Command Queuing (NCQ), Power Management (PM)
Implementation Algorithm, and Hot Swap. Serial ATA allows thinner, more flexible
cables with lower pin count and reduced voltage requirements.

Serial ATA lll technology

The motherboard supports the Serial ATA Il technology through the Serial ATA
interface and Intel® C602 chipset, delivering up to 6Gb/s data transfer rates.
Additionally, get enhanced scalability, faster data retrieval, double the bandwidth of
current bus systems.

ASUS Z9NA-D6 1-5



USB 2.0 technology

The motherboard implements the Universal Serial Bus (USB) 2.0 specification,
dramatically increasing the connection speed from the 12 Mbps bandwidth on USB
1.1 to a fast 480 Mbps on USB 2.0. USB 2.0 is backward compatible with USB 1.1.

Temperature, fan, and voltage monitoring

The CPU temperature is monitored to prevent overheating and damage. The
system fan rotations per minute (RPM) is monitored for timely failure detection.
The chip monitors the voltage levels to ensure stable supply of current for critical
components.

1.4.2 Innovative ASUS features

ASUS Fan Speed control technology

The ASUS Fan Speed control technology smartly adjusts the fan speeds according
to the system loading to ensure quiet, cool, and efficient operation.

PIKE (Proprietary 1/0 Kit Expansion)

PIKE is an on-demand upgrade kit for users. This ASUS unique feature enables
users to choose their preferred 1/0 solutions. ASUS provides multiple SAS
solutions for different segments and purposes and PIKE saves lots of validation
efforts and hardware cost for end users.

ASUS MIO Audio card

Enjoy high-end sound quality! The ASUS MIO audio card is a discrete 8-channel
high definition audio (High Definition Audio previously codenamed Azalia) CODEC
that offers the clearest high quality audio output, jack-sensing feature, retasking
functions, and multi-streaming technology that simultaneously send different audio
streams to different destinations.

Chapter 1: Product introduction



This chapter lists the hardware setup
procedures that you have to perform
when installing system components. It
includes description of the jumpers and
connectors on the motherboard.

Hardware
information
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2.1 Before you proceed

Take note of the following precautions before you install motherboard components or change
any motherboard settings.

) ' \ + Unplug the power cord from the wall socket before touching any
e component.

+ Use a grounded wrist strap or touch a safely grounded object or a metal
object, such as the power supply case, before handling components to
avoid damaging them due to static electricity.

Hold components by the edges to avoid touching the ICs on them.

Whenever you uninstall any component, place it on a grounded antistatic
pad or in the bag that came with the component.

Before you install or remove any component, ensure that the power supply
is switched off or the power cord is detached from the power supply. Failure
to do so may cause severe damage to the motherboard, peripherals, and/or
components.

Standby Power LED (SB_PWR1)

The motherboard comes with a standby power LED. The green LED lights up to
indicate the system AC power cable plug or not. This is a reminder that you should
shut down the system and unplug the power cable before removing or plugging

in any motherboard component. The illustration below shows the location of the
onboard LED.

(S

SB_PWR1
- = =0 —> I &=
o i 8 on o
ZQNA'DG Onboard LED Standy Power Powered Off

ASUS Z9NA-D6
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2.2 Motherboard overview

Before you install the motherboard, study the configuration of your chassis to
ensure that the motherboard fits into it.

To optimize the motherboard features, we highly recommend that you install it in an
ATX 2.2 compliant chassis.

/ é \ Ensure to unplug the chassis power cord before installing or removing the
/ motherboard. Failure to do so can cause you physical injury and damage
motherboard components!

2.2.1 Placement direction

When installing the motherboard, ensure that you place it into the chassis in the
correct orientation. The edge with external ports goes to the rear part of the chassis
as indicated in the image below.

2.2.2 Screw holes

Place nine (9) screws into the holes indicated by the circles to secure the
motherboard to the chassis.

/ ' \ DO NOT overtighten the screws! Doing so can damage the motherboard.

Z9NA-D6

Place this side towards
the rear of the chassis

Of
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]
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oy

10000
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2.2.3 Motherboard layout
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224 Layout contents

Slots/Sockets Page
1. CPU sockets 2-9
2. DDR3 sockets 2-13
3. PCI Express x8 / PCI Express x16 slots 2-16
Onboard LEDs Page
1. Baseboard Management Controller (BMC_LED1) 2-20
2. CPU Warning LED (ERR_CPU1/2) 2-20
3. CATT Error LED (CATTERR_LED1) 2-21
Jumpers Page
1. Clear RTC RAM (CLRTC1) 2-22
2. VGA controller setting (3-pin VGA_SW1) 2-23
3. LAN controller setting (3-pin LAN_SW1/LAN_SW2) 2-23
4. LSI MegaRAID or Intel RSTe selection jumper (3-pin RAID_SEL1) 2-24
5. ME firmware force recovery setting (3-pin ME_RCVR1) 2-24
6. DDR3 thermal event setting (3-pin DIMMTRIP1) 2-25
7. PMBus1.2 PSU select jumper (3-pin SMART_PSU1) 2-25
Rear panel connectors Page
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2. USB 2.0 ports 1 and 2 2-26
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Internal connectors Page

1. Serial ATA 6.0/3.0 Gb/s connectors .07
(7-pin SATABG 1-2 [Blue]; 7-pin SATA3G 3-6 [Black])

2. SATA connectors-ISAS connectors 007
(7-pin ISAS1-4 [Gray])

3. SAS connectors 008
(7-pin PSAS1-8 [Blue])
Hard disk activity LED connector (4-pin HDLED1) 2-28
USB connectors (10-1 pin USB56, USB78; A-Type USB9) 2-29
CPU, front and rear fan connectors 299
(4-pin CPU_FAN1-2, FRNT_FAN1-4, REAR_FAN1-2) )

7. Serial General Purpose Input/Output connectors 230
(8-1 pin PSGPIO 1/2, ISGPIO1, SGPIO1)
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10. 24+8-pin EATX power connectors (24-pin EATXPWR1, 8-pin 030
EATX12V1) )

11. Power Supply SMBus (5-pin PSUSMB1) 2-33

12. 4-pin Power Connector (4-pin EZ_PLUG1) 2-33
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14. Auxiliary panel connector (20-2 pin AUX_PANEL1) 2-35
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2.3 Central Processing Unit (CPU)

The motherboard comes with a surface mount LGA1356 socket designed for the
Intel® Xeon E5-2400 family processor.

' \ +  Upon purchase of the motherboard, ensure that the PnP cap is on
g the socket and the socket contacts are not bent. Contact your retailer
immediately if the PnP cap is missing, or if you see any damage to the PnP
cap/socket contacts/motherboard components. ASUS will shoulder the cost
of repair only if the damage is shipment/transit-related.

Keep the cap after installing the motherboard. ASUS will process Return
Merchandise Authorization (RMA) requests only if the motherboard comes
with the cap on the LGA1356 socket.

The product warranty does not cover damage to the socket contacts
resulting from incorrect CPU installation/removal, or misplacement/loss/
incorrect removal of the PnP cap.

2.3.1 Installing the CPU

[z S ]

|

1
CPU2 CPU1 0

g
- (8 °
O g
E@ H E:
R

=tel==

D
i
r““E;%L“““ﬁﬁhLAﬂﬂﬂﬂﬂﬂﬂﬂﬂ d

Z9NA-D6 CPU LGA1356 Socket

R Before installing the CPU, ensure that the socket box is facing toward you and
the load lever is on your left.

ASUS Z9NA-D6
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2.3.2
1.

Intel LGA1356 Socket

Locate the CPU socket on the
motherboard.

2. Pressthe load lever with your

thumb (A), then move it to the left
(B) until it is released from the
retention tab.

/\

'\\ To prevent damage to the socket
/o \

LI

pins, do not remove the PnP cap

unless you are installing a CPU.

3.  Lift the load lever in the direction of

the arrow to a 135° angle (C), then
lift the load plate with your thumb
and forefinger to a 100° angle (D).

4.  Remove the PnP cap from the CPU

socket.

s

Retention tab

/

~
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5.  Position the CPU over the socket,
ensuring that the gold triangle is
on the bottom-left corner of the
socket, and then fit the socket
alignment key into the CPU notch.

\
' \
L/ L

6.  Apply some Thermal Interface
Material to the exposed area of
the CPU that the heatsink will be
in contact with, ensuring that it is
spread in an even thin layer.

Some heatsinks come with pre-
applied thermal paste. If so, skip
this step.

The Thermal Interface Material is
toxic and inedible. DO NOT eat it.
If it gets into your eyes or touches
your skin, wash it off immediately,
and seek professional medical
help.

ASUS Z9NA-D6

CPU notch

~

” Gold
triangle

Alignment key

The CPU fits in only one correct orientation. DO NOT force the CPU into the
socket to prevent bending the connectors on the socket and damaging the CPU!

s

N




7.

Close the load plate (E), and then
push the load lever (F) until it snaps
into the retention tab.

N

Connect the CPU fan cable to the connector on the motherboard labeled
CPU_FAN1 / CPU_FAN2.
_0> @ CPU_FAN1 @ CPU_FAN2

GND

FAN Power
FAN Speed
PWM Control

[=)
z
O

- lBB3BEEREE

PWM Control
FAN Speed
FAN Power

Z9NA-D6 CPU FAN connectors

R DO NOT forget to connect the CPU fan connector! Hardware monitoring errors
can occur if you fail to plug this connector.
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2.4 System memory

241 Overview

The motherboard comes with three (per CPU) Double Data Rate 3 (DDR3) Dual
Inline Memory Modules (DIMM) sockets.

A DDR3 module has the same physical dimensions as a DDR2 DIMM but is
notched differently to prevent installation on a DDR2 DIMM socket. DDR3 modules
are developed for better performance with less power consumption.

The figure illustrates the location of the DDR3 DIMM sockets:

L 1 DIMM_A1
L. I DIMM_B1

Y

L 1 DIMM_C1

e ———
1 - :
2] O

&
Il

O
DD =

LI — D
[] —= . n

mm o

T o — O oom HHEER
= L7 O] q
— = 000000n #

Z9NA-D6 240-pin DDR3 DIMM sockets

24.2 Memory Configurations

You may install 1GB, 2GB, 4GB, 8GB, 16GB and 32GB* RDIMMs or 1GB, 2GB,
4GB and 8GB* with ECC/Non-ECC UDIMMs or 8GB, 16GB and 32GB* LR-DIMMs
into the DIMM sockets using the memory configurations in this section.

1 CPU Configuration (must on CPU1)

DIMM_A1 |DIMM_B1 |DIMM_C1
1 DIMMs X
2 DIMMs X X
3 DIMMs X X X

R + *Refer to ASUS Server AVL for latest update.
Install the DIMMS starting from slot A1 (CPU1) and D1 (CPU2).

Always install DIMMs with the same CAS latency. For optimum
compatibility, it is recommended that you obtain memory modules from the
same vendor.
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2 CPU Configuration

DIMM_A1 |[DIMM_B1 |DIMM_C1 |DIMM_D1 |DIMM_E1 |DIMM_F1
1 DIMMs X
2 DIMMs X X
4 DIMMs X X X X
16 DIMMs X X X X X X
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2.43 Installing a DIMM on a single clip DIMM socket

1. Unlock a DIMM socket by pressing DIMM notch
the retaining clip outward.

2. Align a DIMM on the socket
such that the notch on the DIMM
matches the DIMM slot key on the
socket.

DIMM slot key Unlocked retaining clip

4& A DIMM is keyed with a notch so that it fits in only one direction. DO NOT force
a DIMM into a socket in the wrong direction to avoid damaging the DIMM.

3. Hold the DIMM by both of its ends,
then insert the DIMM vertically ’
into the socket. Apply force to both . o
ends of the DIMM simultaneously :
until the retaining clip snaps back ’
into place, and the DIMM cannot
be pushed in any further to ensure

proper sitting of the DIMM. Locked Retaining Clip

Always insert the DIMM into the socket VERTICALLY to prevent DIMM notch
damage.

\

/ ! \\

R +  Toinstall two or more DIMMSs, refer to the user guide bundled in the
motherboard package.

+  Refer to the user guide for qualified vendor lists of the memory modules.

Removing a DIMM from a single clip DIMM socket

1. Press the retaining clip outward to
unlock the DIMM.

2. Remove the DIMM from the socket.

% Support the DIMM lightly with your fingers when pressing the retaining clips.
The DIMM might get damaged when it flips out with extra force.
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2.5 Expansion slots

In the future, you may need to install expansion cards. The following subsections
describe the slots and the expansion cards that they support.

/ / \ Ensure to unplug the power cord before adding or removing expansion cards.
/ Failure to do so may cause you physical injury and damage motherboard
components.

2.5.1 Installing an expansion card

To install an expansion card:

1.

Before installing the expansion card, read the documentation that came with
it and make the necessary hardware settings for the card.

Remove the system unit cover (if your motherboard is already installed in a
chassis).

Remove the bracket opposite the slot that you intend to use. Keep the screw
for later use.

Align the card connector with the slot and press firmly until the card is
completely seated on the slot.

Secure the card to the chassis with the screw you removed earlier.
Replace the system cover.

2.5.2 Configuring an expansion card

After installing the expansion card, configure it by adjusting the software settings.

1.

Turn on the system and change the necessary BIOS settings, if any. See
Chapter 4 for information on BIOS setup.

Assign an IRQ to the card. Refer to the tables on the next page.
Install the software drivers for the expansion card.

R When using PCI cards on shared slots, ensure that the drivers support “Share

IRQ” or that the cards do not need IRQ assignments. Otherwise, conflicts will
arise between the two PCI groups, making the system unstable and the card
inoperable.
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2.5.3 PCI Express x16 slot (x16 link)

The onboard PCIE 1 (slot location 6) provides one x16 Geng3 link to CPU1. These
slots support VGA cards and various server class high performance add-on cards.

254 PCI Express x8 slot (x8 link)

The onboard PCIE 2 (slot location 4) and 3 (slot location 3) provide one x8 Gen3
link to CPU2. These slots support various server class high performance add-on
cards.

2.5.5 PCI Express x8 slot (x4 link)

The onboard PCIE 4 (slot location 2) provides one x4 Gen2 link to Intel C602 PCH.
This slot supports various server class high performance add-on cards.

2.5.6 PCI Express x1 slot (x1 link)
The onboard PCIE 5 (slot location 1) provides one x1 Gen2 link to Intel C602 PCH.
REFHARRES

'DDR3 DIMM_A1 (640, 240-pin module)

\ oo o o1 o 210 o ]

[ DR OWVLCT (o 21051 o) ]

Z9NA-D6

5D VI i 2 o) ]

\ o DoAY o st ]
NsSUus

DO DI o ]

Hell= e oot s | 1 x PCI-E x 16 (Gen3 x16 link)

Hell= 2l eesiie ] 1 x PCI-E x 8 (Gen3 x8 link)

Hell= el et €| 1 x PCI-E x 8 (Gen3 x8 link)
Hell= e et | 1 x PCI-E x 8 (Gen2 x4 link)

Hel= e leleeiilon | 1 x PCI-E x 1 (Gen2 link)

2.5.7 PIKE slots

The PIKE slot allows you to choose and change your preferred SAS solution easily.
Install an optional ASUS PIKE RAID card based on your needs.

ASUS Z9NA-D6



25.8 Installing an ASUS PIKE RAID card (Optional)

Follow the steps below to install an optional ASUS PIKE RAID card on your
motherboard.

1.

Locate the PIKE RAID card slot on the motherboard.

Insert the PIKE RAID card into the PIKE RAID card slot. Ensure that it is
completely seated on the PIKE RAID card slot.

% Please refer to Chapter 2.8.2 for SAS connector location.
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25.9 Installing ASMB6 management board

Follow the steps below to install an optional ASMB6 management board on your
motherboard.

1. Locate the ASMB6 header on the
motherboard.

2. Orient and press the ASMB6
management card in place.

2.5.10 Installing the audio card

1. Locate the PCIE5 card slot on the
motherboard and align the golden
fingers of the audio card with the
PCIES5 card slot.

2. Insertthe audio card into the PCIE5
card slot. Ensure that it is completely
seated on the card slot.

3. Secure the audio card to the
chassis with a screw.

ASUS Z9NA-D6
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2.6 Onboard LEDs

1.  Baseboard Management Controller LED (BMC_LED1)

The BMC LED works with the ASUS ASMB6 management device and indicates
its initiation status. When the PSU is plugged and the system is OFF, ASUS
ASMB6 management device starts system initiation for about one (1) minute.
The BMC LED blinks after system initiation finishes.

» BMC_LED1

Z9NA-D6 BMC LED

2.  CPU warning LED (ERR_CPU1/2)
The CPU warning LEDs light up to indicate that an impending failure of the

corresponding CPU.
IBEEHREEE E{T}DDED
. = » ERR_CPU1
=i Mlﬂj@
iy, EH » ERR_CPU2
—
——— ]
—————
A
=

o B e
= i
Z9NA-D6 ERR CPU LED

% The warning LEDs function only when you install the ASUS ASMB6.
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3.  CATT Error LED (CATTERR_LED1)

Indicates that the system has experienced a fatal or catastrophic error and
cannot continue to operate.

» ICATTERR_LED1

N7

oc—n
b o
Goe
0.1.::0
29NA-D6
Hots

O

0

D E— D

- 3o R
xS W0

ZQNA-DG CATTERR LED
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2.7 Jumpers

1. Clear RTC RAM (CLRTC1)

This jumper allows you to clear the Real Time Clock (RTC) RAM in CMOS.
You can clear the CMOS memory of date, time, and system setup parameters
by erasing the CMOS RTC RAM data. The onboard button cell battery
powers the RAM data in CMOS, which include system setup information such
as system passwords.

To erase the RTC RAM:

1. Turn OFF the computer and unplug the power cord.

2. Move the jumper cap from pins 1-2 (default) to pins 2-3. Keep the cap
on pins 2-3 for about 5-10 seconds, then move the cap back to pins 1-2.

3. Plug the power cord and turn ON the computer.

4. Hold down the <Del> key during the boot process and enter BIOS setup
to re-enter data.

Except when clearing the RTC RAM, never remove the cap on CLRTC jumper
default position. Removing the cap will cause system boot failure!

% If the steps above do not help, remove the onboard battery and move the
jumper again to clear the CMOS RTC RAM data. After the CMOS clearance,
reinstall the battery.

CLRTCH

12 2 3

Normal Clear CMOS

N a1 110001005 > (Default)

Z9NA-D6 Series Clear RTC RAM
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2.  VGA controller setting (3-pin VGA_SW1)

This jumper allows you to enable or disable the onboard VGA controller. Set
to pins 1-2 to activate the VGA feature.

s “{T}mmmu
——
[ ——
—
0
g
lﬁ T
8 ]
I:I
Ore—7c= . VGA_SWi1
5 = > 12 2 3
F—"17 - - e - -
mn g J Enable Disable
— e ] mm [
= I:IE ““ 0 (Default)
— @’m L00000OD =

Z9NA-D6 Series VGA setting

3.  LAN controller setting (3-pin LAN_SW1/LAN_SW2)
These jumpers allow you to enable or disable the onboard Intel® 82574L
Gigabit LAN controllers. Set to pins 1-2 to activate the Gigabit LAN feature.

T B Teeg LAN_SW1
1 2 2 3
B (= = CINNE] = =
. g . Enable Disable
H (Default)
— LAN_SW2
~ = 1 2 2 3
E III >
Enable Disable
D - D (Default)
EZI]
EI Q
!—\ !—\ﬂﬂﬂﬂﬂﬂﬂﬂ

Z9NA-D6 Series LAN setting
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4. LSl MegaRAID or Intel RSTe selection jumper (3-pin RAID_SEL1)

This jumper allows you to select the PCH SATA RAID mode to use LSI
MegaRAID software or Intel® Rapid Storage Technology enterprise 3.0 RAID.
Place the jumper caps over pins 1-2 if you want to use the LSI MegaRAID
software RAID Utility (default); otherwise, place the jumper caps to pins 2-3
to use the Intel® Rapid Storage Technology Enterprise Option ROM Utility.

RAID_SELA1
12 23
- B

LSI MegaRAID Intel RAID
(Default)

Z9NA-D6 RAID settlng

5. ME firmware force recovery setting (3-pin ME_RCVR1)

This jumper allows you to force Intel Management Engine (ME) boot from
recovery mode when ME become corrupted.

B =LFO0O

[ E——
= ME_RCVR1
) D 12 23
[m] -
e E1(2) S = = EINEE] = = |
DE%D ¥ 0 Normal ME_RCVR
E——l0un000n * (Default)

Z9NA-D6 Series ME firmware setting
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6. DDR3 thermal event setting (3-pin DIMMTRIP1)

This jumper allows you to enable/disable DDR3 DIMM thermal sensing event
pin.

— DIMMTRIP1
O i@ P s
L o @m
IIII F Eanble Disable
e 000000 (Default)

Z9NA-D6 Thermaltrip setting

7. PMBus 1.2 PSU select jumper (3-pin SMART_PSU1)

This jumper allows you to select PSU PMBus version, Setto pins 1-2 for PMBus,
set to pins 2-3 for Others.

EEE S » SMART_PSU1
1 2 23
- C-Ea
PMBus 1.2 Others
(Default)

!—\ @!—\ﬂﬂﬂﬂﬂﬂﬂﬂ

Z9NA-D6 PMBus 1.2 PSU setting
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2.8 Connectors

2.8.1 Rear panel connectors

1
@

i

|
7

1.  PS/2 keyboard/mouse port. This port is for a PS/2 keyboard and mouse.

2. USB 2.0 ports 1 and 2. These two 4-pin Universal Serial Bus (USB) ports
are available for connecting USB 2.0 devices.

3. USB 2.0 ports 3 and 4. These two 4-pin Universal Serial Bus (USB) ports
are available for connecting USB 2.0 devices.

COM port.

5.  Video Graphics Adapter port. This port is for a VGA monitor or other VGA-
compatible devices.

6. LAN 1 (RJ-45) port. This port allows Gigabit connection to a Local Area
Network (LAN) through a network hub. Refer to the table below for the LAN
port LED indications.

7. LAN 2 (RJ-45) port. This port allows Gigabit connection to a Local Area
Network (LAN) through a network hub. Refer to the table below for the LAN
port LED indications.

LAN port LED indications

ACT/LINK SPEED

Activity/Link LED Speed LED LED LED
Status Description  Status Description

OFF No link OFF 10 Mbps connection ‘ -
Green |Linked |Orange 100 Mbps connection |

Blinking |Data activity |Green 1 Gbps connection m
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2.8.2 Internal connectors

1. Serial ATA 6.0/3.0 Gb/s connectors (7-pin SATA6G_1-2 [Blue]; 7-pin
SATA3G_3-6 [Black])

These connectors connect to Serial ATA 6.0Gb/s or 3.0 Gb/s hard disk drives
and optical disc drives via Serial ATA 6.0Gb/s or 3.0 Gb/s signal cables.

SATA1 SATA2 SATA3
RsATA TxP1 |} RSATA_TxP2 |} RSATA T3 |}
RSATA TXN1 | RSATA TN || RSATA TXNG |
RSATA RXP1 1 RATA AXP2 | | RSATA_AXP3—| |
RSATA_RXN1— RSATA_RXN2— RSATA_RXN3—

SATA4 SATAS SATA6
rsATA Txpa—| | RsaTA Txps—| | rsaTA Txpo—| |
RSATA_TXN4—H RSATA_TXN5—H RSATA_TXN6 —H

~D ] o] o]
RSATA AXP4—| RSATA RXPs—| | ASATA RXPo—| |
RSATA_RXN4— ]} RSATA XN} RSATA RXN6 |}

Z9NA-D6 SATA connectors

2.  SATA connectors — ISAS connectors (7-pin ISAS1-4 [Gray])

Supported by Intel C602 PCH, ISAS 1-4 connectors connect to Serial ATA
3.0 Gb/s hard disk drives and optical disk drives via Serial ATA 3.0 Gb/s signal
cables.

R The actual data transfer rate depends on the speed of SATA hard disks installed.

ﬂ.--)»

ano anp ano ano
RSATA_TXNT RSATA TXN2 RSATA TXNS RSATA_TXNA
RSATA TXP1 RSATA TxP2 RSATA TXPS RSATA TXP4

RSATA_RXN1
RSATA_RXP1
af

Z9NA-D6 SATA connectors (SCU)

RSATA_RXN2
RSATA RXP2

RSATA_RXNG
RSATA_RXP3
GND

RSATA_RXNd
RSATA_RXP4

ISAS1
ISAS2
ISAS3
ISAS4
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3.  SAS connectors (7-pin PSAS1-8 [Blue])

Supported by the ASUS® PIKE Card, these connectors are for the SAS signal
cables for SAS hard disk drives that allows up to 6Gb/s of data transfer rate.

If you installed SAS hard disk drives, you can create a RAID 0, RAID 1, RAID
10, or RAID 5 configuration.

oo ac—n

RSATA_TXNS
RSATA_TXP8

RSATA_TXN7

. RSATA_TXNG
RSATA_TXP7

RSATA_TXP6

RSATA_TXNS
RSATA_TXPS

PSAS8
PSAS7
PSAS6
PSAS5

RSATA_RXN8
RSATA_RXP8

RSATA_RXN?
RSATA_RXP7

RSATA_RXN6
RSATA_RXP6

RSATA_RXNS
RSATA_RXP5

RSATA_TXN4 RSATA_TXN3
RSATA_TXP4 RSATA_TXP3
GND
RSATA_RXN4
RSATA_RXP4
GND

RSATA_TXN2
RSATA_ TXP2

RSATA_TXN1
RSATA_TXP1

RSATA_RXN3
RSATA_RXP3

RSATA_RXN2
RSATA_RXP2

RSATA_RXN1
RSATA_RXP1

PSAS4
PSAS3

PSAS2
PSAS1

GND GND%

& o
o QI —>
Z9NA-D6 SAS connectors (PIKE)

R The actual data transfer rate depends on the speed of SAS hard disks installed.

4. Hard disk activity LED connector (4-pin HDLED1)

This LED connector is for the storage add-on card cable connected to

the SATA or SAS add-on card. The read or write activities of any device
connected to the SATA or SAS add-on card causes the front panel LED to
light up.

ADD_IN_CARD-

ADD_IN_CARD-

NC
NC

HDLED1

Z9NA-D6 Storage card activity LED connector
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5.  USB connectors (10-1 pin USB56, USB78; A-Type USB9)

These connectors are for USB 2.0 ports. Connect the USB module cables to
connectors USB34 and USB56, then install the modules to a slot opening at

the back of the system chassis. These USB connectors comply with USB 2.0
specification that supports up to 480 Mbps connection speed.

O USB9
=
]
E —C> !
] - ()
[ DmT:I ) ?
= iitee—2

Z9NA-D6 USB 2.0 connectors

6. CPU, front and rear fan connectors
(4-pin CPU_FAN1-2, FRNT_FAN1-4, REAR_FAN1-2)
The fan connectors support cooling fans. Connect the fan cables to the fan
connectors on the motherboard, ensuring that the black wire of each cable
matches the ground pin of the connector.

cad)>
|~

® USB78

GND
USB_P7+
USB_P7-
USB+5V

o

NG
USB_P8
USB+5V

GND
USB_P8+

© USBSG

USB+5V
USB_P6-
USB_P6+

GND
NC

PINT

USB+5V
USB_P5
USB_P5+

GND

DO NOT forget to connect the fan cables to the fan connectors. Insufficient
air flow inside the system may damage the motherboard components.

These are not jumpers! DO NOT place jumper caps on the fan connectors!
All fans feature the ASUS Fan Speed Control technology.

2
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— l Z E)—)
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Z9NA-D6 FAN connectors
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FAN Speed

FAN Power

GND
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GND

FAN Power
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( REAR_FAN2

FAN Power
FAN Speed
PWM Control

GND

E

FRNT_FAN1
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GND %

PWM Control
FAN Speed
FAN Power

©® FRNT_FAN3

PWM Control —{—ll
FAN Speed ——l
FAN Power ——ll

GND——

© FRNT_FAN4

PWM Control —{—ll
FAN Speed ——l
FAN Power ——ll

GND——

© FRNT_FAN2

PWM Control——ll
FAN Speed——ll
FAN Power——l

GND—

©® REAR_FAN{

GND

FAN Power
FAN Speed
PWM Control
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7.  Serial General Purpose Input/Output connectors
(8-1 pin PSGPIO 1/2, ISGPIO1, SGPIO1)

The SGPIO 1 connectors are used for the Intel Rapid Storage Technology
Enterprise SGPIO interface that controls the LED pattern generation, device
information and general purpose data.

+ The PSGPIO 1/2 connectors are used for PIKE card.

+  The ISGPIO 1 connector is for SATA connectors-ISAS connectors.

PSGPIO2  PSGPIO1

SI0_DOUT
SI0_DOUT
GND

SIO_DIN
GND
SIO_DIN

=
g

PIN T PIN T

GND
GND
SIO_END
GND
GND

SIO_CLK
SIO_END
SIO_CLK

ISGPIO1

SI0_DOUT

SIO_DIN
GND

=

PIN T

GND
GND
SIO_END

SIO_CLK

SGPIO_SCLK

SGPIO_SDATAOUTO
SGPIO_SDATAOUT1
SGPIO_SLOAD

GND

SGPIO1

:

PINT

Z9NA-D6 SGPIO connector
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8.  Serial port connectors (10-1 pin COM2)
These connectors are for the serial (COM) ports. Connect the serial port
module cable to one of these connectors, then install the module to a slot
opening at the back of the system chassis.

COM2
i reaas

E= 00000 ® o

Z9NA-D6 Serial port connector

9.  TPM connector (20-1 pin TPM1)

This connector supports a Trusted Platform Module (TPM) system, which can
securely store keys, digital certificates, passwords, and data. A TPM system
also helps enhance network security, protects digital identities, and ensures
platform integrity.

jesgsiaseees) = e

ND
NC
LAD2
LAD1
SERIRQ
CLKRUN

a
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S [op= z
nsus
O =
- TPMA1
[m] = &
= = PIN 1
I e SLr858282¢E
L e— - O=PS*S 305
mm o or= ¥
—— })—-9» U0
e 1 O l:ll o z

e

Z9NA-D6 TPM connector
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10. 24+8-pin EATX power connectors (24-pin EATXPWR1, 8-pin EATX12V1)

These connectors are for the SSI or ATX power supply plugs. The power supply
plugs are designed to fit these connectors in only one orientation. Find the proper
orientation and push down firmly until the connectors completely fit.

%\ + DO NOT forget to connect the 24+8-pin power plugs; otherwise, the system
will not boot up.

Use of a PSU with a higher power output is recommended when configuring
a system with more power-consuming devices. The system may become
unstable or may not boot up if the power is inadequate.

Ensure that your power supply unit (PSU) can provide at least the minimum
power required by your system (470W or above; 12V1 > 20A).

— EATXPWR1

m
GND 3_>|
aND 37
GND 2%
GND N

<

=

+3 Volts
+3 Volts
GND
+5 Volts
GND
+5 Volts
GND
Power OK
+5V Standby
+12 Volts
+12 Volts
+3 Volts
3
ES

PIN1

+12V DC
+12VDC

+12VDC
+12V DC

+3 Volts
12 Volts
GND
PSON#
GND
GND
GND
-5 Volts
+5 Volts
+5 Volts
+5 Volts
GND

Z9NA-D6 ATX power connectors
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11. Power Supply SMBus connector (5-pin PSUSMB1)

This connector allows you to connect SMBus (System Management Bus) to
the power supply unit to read PSU information. Devices communicate with an
SMBus host and/or other SMBus devices using the SMBus interface.

— PSUSMB1

g

GND

NC
12C_7_DATA#
12C_7_CLK#

+3.3V Remote Sense

| E—
=il -
rﬁ!—\ﬁﬂﬂﬂﬂﬂﬂﬂﬂ
Z9NA-D6 Power supply SMBus connector

12. 4-pin Power Connector (4-pin EZ_PLUG1)
This 4-pin connector is for 5V power of certain SATA DOM (Disk on Module)
device, when using an appropriate cable. You can also use this 4-pin
connector to connect the PSU to enhance power by 12V.

EZ_PLUGH1
PIN1
+5V
| S_EZ_DET
| —— GND
= L7 Dg] i 2V

— N G (110000
Z9NA-D6 4-pin power connector
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13. System panel connector (20-1 pin PANEL1)
This connector supports several chassis-mounted functions.

PLED
NC
PLED:
MLED+
MLED
NC

+5V
Ground
Ground
Speaker

PANEL1

PIN1

%

| IDE_LED+
Ground
PWR

— Ground
NC

Reset

—— Ground

— [ IDE_LED
NMIBTN#

[IDE_LED] [PWRSW][RESET]

Z9NA-D6 System panel connector

(1) System power LED (3-pin PLED)
This 3-pin connector is for the system power LED. Connect the chassis
power LED cable to this connector. The system power LED lights up
when you turn on the system power, and blinks when the system is in
sleep mode.

(2) System warning speaker (4-pin SPEAKER)
This 4-pin connector is for the chassis-mounted system warning
speaker. The speaker allows you to hear system beeps and warnings.

(3) Hard disk drive activity LED (2-pin HDDLED)
This 2-pin connector is for the HDD Activity LED. Connect the HDD
Activity LED cable to this connector. The HDD LED lights up or flashes
when data is read from or written to the HDD.

(4) Power button/soft-off button (2-pin PWRSW)
This connector is for the system power button. Pressing the power
button turns the system on or puts the system in sleep or soft-off mode
depending on the BIOS settings. Pressing the power switch for more
than four seconds while the system is ON turns the system OFF.

(5) Reset button (2-pin RESET)
This 2-pin connector is for the chassis-mounted reset button for system
reboot without turning off the system power.
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14. Auxiliary panel connector (20-2 pin AUX_PANEL1)

This connector is for additional front panel features including front panel
SMB, locator LED and switch, chassis intrusion, and LAN LEDs.

g zo & &
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Z9NA-D6 Auxiliary panel connector

(1) Front panel SMB (6-1 pin FPSMB)
These leads connect the front panel SMBus cable.

(2) LAN activity LED (2-pin LAN1_LED, LAN2_LED)
These leads are for Gigabit LAN activity LEDs on the front panel.

(3) Chassis intrusion (4-1 pin CHASSIS)
These leads are for the intrusion detection feature for chassis with
intrusion sensor or microswitch. When you remove any chassis
component, the sensor triggers and sends a high-level signal to these
leads to record a chassis intrusion event. The default setting is short
CASEOPEN and GND pin by jumper cap to disable the function.

(4) Locator LED (2-pin LOCATORLED1 and 2-pin LOCATORLED?2)
These leads are for the locator LED1 and LED2 on the front panel.
Connect the Locator LED cables to these 2-pin connector. The LEDs will
light up when the Locator button is pressed.

(5) Locator Button/Swich (2-pin LOCATORBTN)
These leads are for the locator button on the front panel. This button
queries the state of the system locator.
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This chapter describes the power up
sequence, and ways of shutting down the
system.

Powering up



3.1
3.2

Starting up for the first time........cccocvcvrnncnnnnn .
Powering off the COMPULEr.......c.ccvvcrerrimsesnssessnss s
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3.1 Starting up for the first time

1. After making all the connections, replace the system case cover.
2. Be sure that all switches are off.

3. Connect the power cord to the power connector at the back of the system
chassis.

4.  Connect the power to a power outlet that is equipped with a surge protector.

5. Turn on the devices in the following order:
a. Monitor
b. External storage devices (starting with the last device on the chain)
c. System power

6.  After applying power, the system power LED on the system front panel case
lights up. For systems with ATX power supplies, the system LED lights up
when you press the ATX power button. If your monitor complies with “green”
standards or if it has a “power standby” feature, the monitor LED may light up
or switch between orange and green after the system LED turns on.

The system then runs the power-on self-test or POST. While the tests are
running, the BIOS beeps or additional messages appear on the screen. If you
do not see anything within 30 seconds from the time you turned on the power,
the system may have failed a power-on test. Check the jumper settings and
connections or call your retailer for assistance.

7. At power on, hold down the <Del> key to enter the BIOS Setup. Follow the
instructions in Chapter 4.
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3.2 Powering off the computer
3.2.1 Using the OS shut down function

If you are using Windows® 2008 Server:

1. Click the Start button, move the cursor to the triangle on the right of Log off,
and then click Shut Down.

2. From the Shutdown Event Tracker, select the option that best describes
why you want to shut down the computer.

3.  Ensure that the Planned check box is checked.
4.  If necessary, key in comments.
5.  Click OK.

3.2.2 Using the dual function power switch

While the system is ON, pressing the power switch for less than four seconds puts
the system to sleep mode or to soft-off mode, depending on the BIOS setting.
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This chapter tells how to change the
system settings through the BIOS Setup
menus. Detailed descriptions of the BIOS
parameters are also provided.

BIOS setup
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4.1 Managing and updating your BIOS

The following utilities allow you to manage and update the motherboard Basic
Input/Output System (BIOS) setup:

1. ASUS CrashFree BIOS 3 (To recover the BIOS using a bootable USB flash
disk drive when the BIOS file fails or gets corrupted.)

2. ASUS EZ Flash 2 (Updates the BIOS using a USB flash disk.)

3. BUPDATER utility (Updates the BIOS in DOS mode using a bootable USB
flash disk drive.)

Refer to the corresponding sections for details on these utilities.

Save a copy of the original motherboard BIOS file to a bootable USB flash
R disk drive in case you need to restore the BIOS in the future. Copy the original
motherboard BIOS using the BUPDATER utility.

411 ASUS CrashFree BIOS 3 utility

The ASUS CrashFree BIOS 3 is an auto recovery tool that allows you to restore
the BIOS file when it fails or gets corrupted during the updating process. You can
update a corrupted BIOS file using a USB flash drive that contains the updated
BIOS file.

R Prepare a USB flash drive containing the updated motherboard BIOS before
using this utility.

Recovering the BIOS from a USB flash drive

To recover the BIOS from a USB flash drive:

1. Insert the USB flash drive with the original or updated BIOS file to one USB
port on the system.

2. The utility will automatically recover the BIOS. It resets the system when the
BIOS recovery finished.

) '\\ DO NOT shut down or reset the system while recovering the BIOS! Doing so
e would cause system boot failure!

The recovered BIOS may not be the latest BIOS version for this motherboard.
Visit the ASUS website at www.asus.com to download the latest BIOS file.

ASUS Z9NA-D6
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41.2  ASUS EZ Flash 2 Utility

The ASUS EZ Flash 2 Utility feature allows you to update the BIOS without having
to use a DOS-based utility.

Before you start using this utility, download the latest BIOS from the ASUS
website at www.asus.com.

To update the BIOS using EZ Flash 2 Utility

1. Insert the USB flash disk that contains the latest BIOS file to the USB port.
2. Enter the BIOS setup program. Go to the Tool menu to select ASUS EZ
Flash 2 Utility and press <Enter> to enable it.

ASUSTek EZ Flash 2 Utility V01.0:
fl Flash Inf
MODEL: ZONA-D6

fs0:\
Folder Info

12/09/10  10:23p 4194304 Z9NA-D6-ASUS-0304.ROM

il File Infor

MODEL:

© Help Info

[Enter] Selector Load  [Tab] Switch  [Up/Down/PageUp/PageDown/Home/End] Move  [Esc] Exit  [F2] Backup

3.  Press <Tab> to switch to the Drive field.

Press the Up/Down arrow keys to find the USB flash disk that contains the
latest BIOS, and then press <Enter>.

5.  Press <Tab> to switch to the Folder Info field.

6. Press the Up/Down arrow keys to find the BIOS file, and then press <Enter>
to perform the BIOS update process. Reboot the system when the update
process is done.
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This function can support devices such as a USB flash disk with FAT 32/16
format and single partition only.

+ DO NOT shut down or reset the system while updating the BIOS to prevent
system boot failure!

R Ensure to load the BIOS default settings to ensure system compatibility and
stability. Press <F5> and select Yes to load the BIOS default settings.

41.3 BUPDATER utility

k The succeeding BIOS screens are for reference only. The actual BIOS screen
displays may not be the same as shown.

The BUPDATER utility allows you to update the BIOS file in DOS environment
using a bootable USB flash disk drive with the updated BIOS file.

Updating the BIOS file

To update the BIOS file using the BUPDATER utility:

1. Visit the ASUS website at www.asus.com and download the latest BIOS file
for the motherboard. Save the BIOS file to a bootable USB flash disk drive.

2. Copy the BUPDATER utility (BUPDATER.exe) from the ASUS support
website at support.asus.com to the bootable USB flash disk drive you created
earlier.

3. Boot the system in DOS mode, then at the prompt, type:

BUPDATER /i[filename] .ROM

where [filename] is the latest or the original BIOS file on the bootable USB
flash disk drive, then press <Enter>.

A:\>BUPDATER /i[file name] .ROM

ASUS Z9NA-D6
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The utility verifies the file, then starts updating the BIOS file.

ASUSTek BIOS Update for DOS V1.06 (09/08/04)
FLASH TYPE: NRICHZSEIG0SE—

Current ROM
BOARD:
VER:
DATE:

PATH:

Update ROM
BOARD
VE
D.

WARNING! Do not turn off power during flash BIOS

Note
Writing BIOS:

o system boot failure!

'\ DO NOT shut down or reset the system while updating the BIOS to prevent
\

5. The utility returns to the DOS prompt after the BIOS update process is
completed. Reboot the system from the hard disk drive.

The BIOS update is finished!

c:\>

Please restart your system.
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4.2 BIOS setup program

This motherboard supports a programmable firmware chip that you can update
using the provided utility described in section 4.1 Managing and updating your
BIOS.

Use the BIOS Setup program when you are installing a motherboard, reconfiguring
your system, or prompted to “Run Setup.” This section explains how to configure
your system using this utility.

Even if you are not prompted to use the Setup program, you can change the
configuration of your computer in the future. For example, you can enable the
security password feature or change the power management settings. This
requires you to reconfigure your system using the BIOS Setup program so that the
computer can recognize these changes and record them in the CMOS RAM of the
firmware chip.

The firmware chip on the motherboard stores the Setup utility. When you start up
the computer, the system provides you with the opportunity to run this program.
Press <Del> during the Power-On Self-Test (POST) to enter the Setup utility;
otherwise, POST continues with its test routines.

If you wish to enter Setup after POST, restart the system by pressing
<Ctrl+Alt+Delete>, or by pressing the reset button on the system chassis. You can
also restart by turning the system off and then back on. Do this last option only if
the first two failed.

The Setup program is designed to make it as easy to use as possible. Being a
menu-driven program, it lets you scroll through the various sub-menus and make
your selections from the available options using the navigation keys.

R +  The default BIOS settings for this motherboard apply for most conditions
to ensure optimum performance. If the system becomes unstable after
changing any BIOS settings, load the default settings to ensure system
compatibility and stability. Press <F5> and select Yes to load the BIOS
default settings.

The BIOS setup screens shown in this section are for reference purposes
only, and may not exactly match what you see on your screen.

Visit the ASUS website (www.asus.com) to download the latest BIOS file for
this motherboard.

ASUS Z9NA-D6
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Menu items

4.2.1

Aptio Setup Utility -

Advanced Server Mgmt Event Logs

BIOS menu screen

Menu bar

Boot Monitor

Configuration fields

Copyright (C) 2011 Zmerican Megatrends,

General help

Inc.
Security Tool @ Exit

BIOS Information
BIOS Vendor

Core Version
Compliancy

BIOS Version
Build Date

System Date
System Time

Access Level

Memory Information
Total Memory

Processor
CPU Speed
Count:

American Megatrends
4.6.4.1
UEFI 2.1;
0303 x64
03/05/2012

PI 0.9

[sat 01/15/2005]
[15:07:28]

Administrator

4096 MB (DDR3)

2300 MHz
1

Set the Date, Use Tab to
switch between Data elements.

—<: Select Screen

1|: Select Item
Enter: Select Item
+/-: Change Opt.

Fl: General Help

F2: Previous Values
F5: Optimized Defaults
F10: Save & Exit

ESC: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

4.2.2 Menu bar

Navigation keys

The menu bar on top of the screen has the following main items:

Main
Advanced
Server Mgmt
Event Logs
Boot
Monitor

changing the fan settings

Security
Tool
Exit

For changing the security settings
For configuring options for special functions
For selecting the exit options

For changing the basic system configuration

For changing the advanced system settings

For changing the Server Mgmt settings

For changing the event log settings

For changing the system boot configuration

For displaying the system temperature, power status, and

To select an item on the menu bar, press the right or left arrow key on the keyboard
until the desired item is highlighted.

Chapter 4: BIOS setup



4.2.3 Menu items

The highlighted item on the menu bar displays the specific items for that menu. For
example, selecting Main shows the Main menu items.

The other items (Event Logs, Advanced, Monitor, Boot, Tool, and Exit) on the menu
bar have their respective menu items.

424  Submenu items

A solid triangle before each item on any menu screen means that the item has a
submenu. To display the submenu, select the item and press <Enter>.

4.2.5 Navigation keys

At the bottom right corner of a menu screen are the navigation keys for the BIOS
setup program. Use the navigation keys to select items in the menu and change
the settings.

4.2.6  General help

At the top right corner of the menu screen is a brief description of the selected item.

4.2.7  Configuration fields

These fields show the values for the menu items. If an item is user-configurable,
you can change the value of the field opposite the item. You cannot select an item
that is not user-configurable.

A configurable field is enclosed in brackets, and is highlighted when selected. To
change the value of a field, select it and press <Enter> to display a list of options.

4.2.8 Pop-up window

Select a menu item and press <Enter> to display a pop-up window with the
configuration options for that item.

4.2.9 Scroll bar

A scroll bar appears on the right side of a menu screen when there are items that
do not fit on the screen. Press the Up/Down arrow keys or <Page Up> /<Page
Down> keys to display the other items on the screen.

ASUS Z9NA-D6

49



4.3 Main menu

When you enter the BIOS Setup program, the Main menu screen appears. The
Main menu provides you an overview of the basic system information, and allows
you to set the system date, time, language, and security settings.

Aptio Setup Utility - Copyright (C) 2011 American Megatrends, Inc.

Advanced Server Mgmt Event Logs Boot Monitor Security Tool Exit

BIOS Information Set the Date, Use Tab to
BIOS Vendor American Megatrends switch between Data elements
Core Version 4.6.4.1

Compliancy UEFI 2.1; PI 0.9

BIOS Version 0303 x64

Build Date 03/05/2012

System Date [Sat 01/15/2005]

System Time [15:07:28]

Access Level Administrator

Memory Information

Total Memory 4096 MB (DDR3)

—<—: Select Screen
Processor T]: Select Item
CPU Speed 2300 MHz Enter: Select Item
Count: 1 +/-: Change Opt.

Fl: General Help

F2: Previous Values
F5: Optimized Defaults
F10: Save & Exit

ESC: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

4.3.1 System Date [Day xx/xx/xxxx]
Allows you to set the system date.

4.3.2 System Time [xx:xx:xx]
Allows you to set the system time.

Chapter 4: BIOS setup



4.4 Advanced menu

The Advanced menu items allow you to change the settings for the CPU and other
system devices.
/\
'\ Take caution when changing the settings of the Advanced menu items. Incorrect
/o \ field values can cause the system to malfunction.

Aptio Setup Utility - Copyright (C) 2011 American Megatrends, Inc.
Main GVELTEM Server Mgmt Event Logs Boot Monitor Security Tool Exit

Front Panel Type
» CPU Configuration
» CPU Power Management Configuration
» Chipset Configuration
» PCH SATA Configuration
» PCH SCU SAS Configuration
» PCI Subsystem Settings
» USB Configuration
» Trusted Computing —<: Select Screen
» ACPI Settings 1l: Select Item
» WHEA Configuration Enter: Select Item
» APM +/-: Change Opt.
» Serial Port Console Redirection Fl: General Help
» Onboard LAN Configuration F2: Previous Values
» ME Subsystem F5: Optimized Defaults
» Onboard Devices Configuration F10: Save & Exit
» Runtime Error Logging ESC: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

Front Panel Type [AC97]

Allows you to set the front panel audio connector (AAFP) mode to legacy AC'97 or
high-definition audio depending on the audio standard that the front panel audio
module supports.

[HD] Sets the front panel audio connector (AAFP) mode to high
definition audio.
[AC97] Sets the front panel audio connector (AAFP) mode to legacy AC’97
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441

CPU Configuration

Aptio Setup Utility - Copyright (C) 2011 American Megatrends, Inc.
Advanced

CPU Confguration

» Socket 1 CPU Information
Socket 2

CPU Speed
64-bit

Hyper Threading
Active Processor Core
Limit CPUID Maximum
Execute Disable Bit
Server Class

Hardware Prefetcher

Adjacent Cache Line Prefetch

DCU Streamer Prefetcher
DCU IP Prefetcher

Intel Virtualization Technology

Local APIC Mode

Version 2.14.1219.

Not Present

2300 MHz
Supported

[Enabled]
[All]
[Disabled]
[Enabled]
[Custom]
[Enabled]
[Enabled]
[Enabled]
[Enabled]
[Enabled]
[Auto]

Socket 1 CPU Information
Enter to view socket soecific CPU Information.

Aptio Setup Utility - Copyright (C) 2011 American Megatrends, Inc.
Advanced

Socket specific CPU
Information

—<: Select Screen

1]: Select Item
Enter: Select Item
+/-: Change Opt.

Fl: General Help

F2: Previous Values
F5: Optimized Defaults
F10: Save & Exit

ESC: Exit

Copyright (C) 2011 American Megatrends, Inc.

Socket 1 CPU Information

CPU Signature
Microcode Patch

Max CPU Speed

Min CPU Speed
Processor Cores

Intel HT Technology
Intel VT-X Technology

L1l Data Cache
L1l Code Cache
L2 Cache
L3 Cache

Intel (R) Xeon(R) CPU E5-2470

2.30GHz
206d6

613

2300 MHz
1200 MHz
8
Supported
Supported

32kB x8
32kB x8
256kB x8
20480 kB

—<: Select Screen

1l: Select Item
Enter: Select Item
+/-: Change Opt.

Fl: General Help

F2: Previous Values
F5: Optimized Defaults
F10: Save & Exit

ESC: Exit

Version 2. 19.

Copyright (C) 2011 American Megatrends, Inc.
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Hyper Threading [Enabled]

Allows you to enable or disable the Intel Hyper-Threading Technology function.
When disabled, only one thread per activated core is enabled.

Configuration options: [Disabled] [Enabled]

Active Processor Cores [All]

Configuration options: [All] [1] [2] [3] [4] [5] [6] [7]

% Configuration code numbers vary with CPU models.

Limit CPUID Maximum [Disabled]

Setting this item to [Enabled] allows legacy operating system to boot even without
support for CPUs with extended CPUID functions.

Configuration options: [Disabled] [Enabled]

Execute Disable Bit [Enabled]

XP can prevent certain classes of malicious buffer overflow attacks when combined
with a supporting OS (Windows Server 2003 SP1, Windows XP SP2, SuSE Linux
9.2, Redhat Enterprise 3 Update 3). Configuration options: [Disabled] [Enabled]
Server Class [Custom]

Use Intel recommended prefetch settings.

Configuration options: [Enterprise] [High Performance(HPC)] [Custom]
Hardware Prefetcher [Enabled]

This Item allows you to turn on/off the mid level cache(L2) streamer prefetcher.
Configuration options: [Disabled] [Enabled]

Adjacent Cache Line Prefetch [Enabled]

This Item allows you to turn on/off prefetching of adjacent cache lines.
Configuration options: [Disabled] [Enabled]

DCU Streamer Prefetcher [Enabled]

This Item allows you to enable/disable L1 data prefetcher.
Configuration options: [Disabled] [Enabled]

DCU IP Prefetcher [Enabled]

This Item allows you to enable/disable prefetch of next L1 line based upon
sequential load history.

Configuration options: [Disabled] [Enabled]

Intel Virtualization Technology [Enabled]

When enabled, a VMM can utilize the additional hardware capabilities provided by
Vanderpool Technology.
Configuration options: [Disabled] [Enabled]
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Local APIC mode [Auto]

Allows you to select APIC mode.
Configuration options: [Auto][x2APIC] [XAPIC]

4.4.2 CPU Power Management Configuration

Aptio Setup Utility - Copyright (C) 2011 American Megatrends, Inc.
Advanced

CPU Power Management Configuration This item allows you to
enabled power management

Power Technology [Custom] features.

EIST [Enabled]

Turbo Mode [Enabled]

P-STATE Coordination [HW_ALL]

CPU C3 Report [Disabled]

CPU C6 Report [Enabled]

CPU C7 Report [Disabled]

Package C State limit [C6]

Energy Performance [Balanced Performance]

Factory long duration power limit 95 Watts

Long duration power limit 0

Factory long duration maintained 1000 ms

Long duration maintained 0 —<: Select Screen

Recommended short duration powerl 1.2 * Long Duration |ll: Select Item

Short duration power limit 0 Enter: Select Item
+/-: Change Opt.
Fl: General Help
F2: Previous Values
F5: Optimized Defaults
F10: Save & Exit
ESC: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

Power Technology [Custom]

This item allows you to enable power management features.
Configuration options: [Disabled] [Energy Efficient] [Custom]

EIST [Enabled]

This item allows you to enable/disable Intel SpeedStep.
Configuration options: [Disabled] [Enabled]

Turbo Mode [Enabled]

Configuration options: [Disabled] [Enabled]

P-STATE Coordination [HW_ALL]

This item allows you to change P-STATE Coordination type.
Configuration options: [HW_ALL] [SW_ALL] [SW_ANY]
CPU C3 Report [Disabled]

This item allows you to enable/disable CPU C3(ACPI C2) report.
Configuration options: [Disabled] [Enabled]

CPU C6 Report [Enabled]

This item allows you to enable/disable CPU C6(ACPI C3) report.
Configuration options: [Disabled] [Enabled]
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CPU C7 Report [Disabled]
This item allows you to enable/disable CPU C7(ACPI C3) report.
Configuration options: [Disabled] [Enabled)]

Package C State limit [C6]
This item allows you to set package C State limit.
Configuration options: [C0] [C2] [C6] [C7] [No Limit]

Energy Performance [Balanced Performance]

This item allows you to optimize between performance and power savings.
Configuration options: [Performance] [Balanced Performance] [Balanced Energy]
[Energy Efficient]

Factory long duration power limit 95 Watts

Long duration power limit 0

Allows you to set long duration power limit in watts. Use the <+> and <-> keys to
adjust the value.

Factory long duration maintained 1000 ms

Long duration maintained 0

Allows you to set time window which the long duration power is maintained. Use
the <+> and <-> keys to adjust the value.

Recommended short duration power1 1.2 * Long Duration

Short duration power limit 0

Allows you to set short duration power limit in watts. Use the <+> and <-> keys to
adjust the value.
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443 Chipset Configuration

Aptio Setup Utility - Copyright (C) 2011 American Megatrends, Inc.
Advanced

» QPI Configuration QPI Configuration Page
» Memory Configuration

» CPU IIO0 Bridge Configuration

» PCH Configuration

» Intel(R) VT for Directed I/O Configuration

QPI Configuration

Aptio Setup Utility - Copyright (C) 2011 American Megatrends, Inc.
Advanced

Current QPI Link Speed Fast Enable/Disable Isoc
Current QPI Link Freq 8.0 GT/s
Isoc [Enabled]
QPI Link Speed Mode [Fast]
QPI Link Frequency Select [Auto]
QPI LinkOs [Disabled]
QPI LinkOp [Disabled]
QPI Linkl [Enabled]
Isoc [Enabled]

Configuration options: [Disabled] [Enabled]

QPI Link Speed Mode [Fast]

This item allows you to select the QPI link speed as either the fast mode or slow
mode.

Configuration options: [Slow] [Fast]

QPI Link Frequency Select [Auto]

This item allows for selecting the QP! link frequency

Configuration options: [Auto] [6.4 GT/s] [7.2 GT/s (Fast Mode Only)] [8.0 GT/s (Fast
Mode Only)]

QPI LinkOs [Disabled]
Configuration options: [Disabled] [Enabled]

QPI LinkOp [Disabled]
Configuration options: [Disabled] [Enabled]

QPI Link1 [Enabled]
Configuration options: [Disabled] [Enabled]
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Memory Configuration

Aptio Setup Utility - Copyright (C) 2011 American Megatrends, Inc.
Advanced

Compatibility RID [Enabled] i:sfi’:isnf;’;(g;';g)atlblhty
. Functionality mentioned in

Memory Configuration Sandybridge bios spec
Total Memory 4096 MB (DDR3)
Current Memory Mode Independent
Currently Memory Speed 1333 MHz
Mirroring Not Possible
Sparing Not Possible
Memory Mode [Independent]
Numa [Enabled]
DDR Speed [Auto]
Channel Interleaving [Auto]
Rank Interleaving [Auto] Es Aol Gerrm
Patrol Scrub [Disabled] 1 . ey
Demand Scrub [Enabled] En.ter' el e
Data Scrambling [Enabled] gy éhan 5 G
Device Tagging [Disabled] F1: .Genergl Hgl.
Thermal Throtting [CLTT] e i Vafl’ues
Enable High Temp. [Disabled] st Eoiir] il
Allow 2x Refresh [Enabled] 2 Op -

= F10: Save & Exit
Altitude [300 M] ESC: Exit
Memory HOT sensor support [Enabled] :
» DIMM Information

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

Compatibility RID [Enabled]

Support for compatibility revision ID (CRID) functionality mentioned in Sandybridge
BIOS spec. Configuration options: [Enabled] [Disabled]

Memory Mode [Independent]

Select the mode for memory initializaton.
Configuration options: [Independent] [Mirroring] [Lock Step] [Sparing]

Numa [Enabled]

Allows to Enable/Disable Numa.
Configuration options: [Enabled] [Disabled]

% Numa appears when you install two CPUs.

DDR Speed [Auto]

Force DDR speed. Configuration options: [Auto] [Force DDR3 800] [Force DDR3
1066] [Force DDR3 1333] [Force DDR3 1600] [Force DDR3 1866]

Channel Interleaving [Auto]

Select different channel interleaving setting.

Configuration options: [Auto] [1 Way] [2 Way] [3 Way] [4 Way]
Rank Interleaving [Auto]

Select different rank interleaving setting.
Configuration options: [Auto] [1 Way] [2 Way] [4 Way] [8 Way]
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Patrol Scrub [Disabled]

Allows you to Enable/Disable Patrol Scrub.
Configuration options: [Disabled] [Enabled]

Demand Scrub [Enabled]

Allows you to Enable/Disable demand scrubbing feature.
Configuration options: [Enabled] [Disabled]

Data Scrambling [Enabled]

Allows you to Enable/Disable data scrambling.
Configuration options: [Enabled] [Disabled]

Device Tagging [Disabled]

Allows you to Enable/Disable device tagging.
Configuration options: [Enabled] [Disabled]

Thermal Throtting [CLTT]
Configuration options: [Disabled] [OLTT] [CLTT]

Enable High Temp [Disabled]
Configuration options: [Disabled] [Enabled]

Allow 2x Refresh [Enabled]
Configuration options: [Disabled] [Enabled]

Altitude [300 M]

The system altitude above the sea level in meters.
Configuration options: [Auto] [300 M] [900 M] [1500 M] [3000 M]

Memory Hot sensor support [Enabled]
Configuration options: [Disabled] [Enabled]
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DIMM Information

Aptio Setup Utility - Copyright (C) 2011 American Megatrends, Inc.
Advanced

CPUl DIMM Information

Dimm Al Present 1024 MB (DDR3)
Dimm Bl Not Present
Dimm C1 Not Present

CPU2 DIMM Information

CPU 110 Bridge Configuration

Aptio Setup Utility - Copyright (C) 2011 American Megatrends, Inc.
Advanced

Intel (R) I/OAT [Disabled] Enables/Disables Intel (R)
DCA Support Enabled I/0 Acceleration Technology
VGA Priority [Offboard] (I/0RT)

TargetVGA VGA From CPU 0

—<—: Select Screen

1l: Select Item
Enter: Select Item
+/-: Change Opt.

Fl: General Help

F2: Previous Values
F5: Optimized Defaults
F10: Save & Exit

ESC: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

Intel(R) VOAT [Disabled]

Allows you to Enable/Disable Intel I/O accelaration technology.
Configuration options: [Disabled] [Enabled]

VGA Priority [offboard]

Allows you to decide priority between onboard and 1st offboard video device found.
Configuration options: [Onboard] [Offboard)]
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PCH Configuration

Aptio Setup Utility - Copyright (C) 2011 American Megatrends, Inc.
Advanced

Name Patsburg Support for PCH Compatibility]

Stepping 05 (CO Stepping) |Revision ID(CRID)
functionality.

SB Chipset Configuration

PCH Compatibility RID [Disabled]

Gbe Controller [Disabled]

Deep Sx [Disabled]

SCU devices [Enabled]

Onboard SATA RAID Oprom [Enabled]

Audio Configuration

Azalia HD Audio [Enabled]

High Precision Event Timer Configuration —<—: Select Screen

High Precision Timer [Enabled] 1l: Select Item

Enter: Select Item
+/-: Change Opt.

F1l: General Help

F2: Previous Values
F5: Optimized Defaults
F10: Save & Exit

ESC: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

PCH Compeatibility RID [Disabled]

Support for PCH compatibility.
Configuration options: [Disabled] [Enabled]

GbE Controller [Disabled]
Configuration options: [Disabled] [Enabled]

% The following item appears only when you set GbE Controller to [Enabled].

Wake on Lan from S5 [Enabled]
Configuration options: [Disabled] [Enabled)]

Deep Sx [Disabled]
Configuration options: [Disabled] [Enabled in S5] [Enabled in S4 and S5]

Mobile platforms support deep S4/S5 in DC only and desktop platforms support
deep S4/S5 in AC only.

SCU devices [Enabled]
Allows you to enable/disable Patsburg SCU devices.
Configuration options: [Enabled] [Disabled]
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Onboard SATA RAID Oprom [Enabled]

Allows you to enable/disable onboard SATA RAID option rom if Launch Storage
Oprom is enabled. Configuration options: [Disabled] [Enabled]

Audio Configuration

Azalia HD Audio [Enabled]
Allows you to enable/disable Azalia HD Audio.
Configuration options: [Disabled] [Enabled]

High Precision Event Timer Configuration

High Precision Timer [Enabled]

Allows you to enable/disable High Precision Event Timer.
Configuration options: [Disabled] [Enabled]]

Intel(R) VT for Directed I/0 Configuration

Aptio Setup Utility - Copyright (C) 2011 American Megatrends, Inc.
Advanced

Intel(R) VT-d [Disabled] Enables or Disables BIOS ACPI]
Auto Configuration.

Intel(R) VT-d [Disabled]
Allows you to enable or disable Intel VT-d.
Configuration options: [Enabled] [Disabled]

% The following item appears only when you set Intel(R) VT-d to [Enabled].

Coherency Support [Disabled]
Allows you to enable/disable VT-d Engine Coherency support.
Configuration options: [Disabled] [Enabled]

ATS Support [Disabled]
Allows you to enable/disable VT-d Engine address translation services (ATS)
support. Configuration options: [Disabled] [Enabled)]
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444 PCH SATA Configuration

Aptio Setup Utility - Copyright (C) 2011 American Megatrends, Inc.
Advanced

SATA Portl Not Present (1) IDE Mode. (2)AHCI Mode.
SATA Port2 Not Present (3)RAID Mode.

SATA Port3 Not Present

SATA Portéd Not Present

SATA Port5 Not Present

SATA Porté Not Present

SATA Mode [AHCI Mode]

S.M.A.R.T. Status Check [Enabled]

Aggressive Link Power Management [Enabled]

Portl Staggered Spin-up [Disabled]

Port2 Staggered Spin-up [Disabled]

Port3 Staggered Spin-up [Disabled] —<—: Select Screen
Port4 Staggered Spin-up [Disabled] 1|: Select Item
Port5 Staggered Spin-up [Disabled] Enter: Select Item
Port6 Staggered Spin-up [Disabled] +/-: Change Opt.

Fl: General Help

F2: Previous Values
F5: Optimized Defaults
F10: Save & Exit

ESC: Exit
Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

SATA Mode [AHCI Mode]

Allows you to set the SATA configuration.
Configuration options: [Disabled] [IDE Mode] [AHCI Mode] [RAID Mode]

R +  If you want to use the Serial ATA hard disk drives as Parallel ATA physical
storage devices, set this item to [IDE Mode].

If you want the Serial ATA hard disk drives to use the Advanced Host
Controller Interface (AHCI), keep the default setting [AHCI Mode]. The AHCI
allows the onboard storage driver to enable advanced Serial ATA features
that increases storage performance on random workloads by allowing the
drive to internally optimize the order of commands.

If you want to create RAID sets with LS| MegaRAID utility, or Intel® Rapid
Storage Technology Enterprise from the Serial ATA hard disk drives, set this
item to [RAID Mode].

S.M.A.R.T. Status Check [Enabled]

S.M.A.R.T. (Self-Monitoring, Analysis and Reporting Technology) is a monitor
system. When read/write of your hard disk errors occur, this feature allows the hard
disk to report warning messages during the POST.

Configuration options: [Enabled] [Disabled]

Aggressive Link Power Management [Enabled]
Configuration options: [Enabled)] [Disabled]

Port 1/2/3/4/5/6 Staggered Spin-up [Disabled]

AHCI supports staggered spin-up.
Configuration options: [Enabled] [Disabled]
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4.4.5 PCH SCU Configuration

This item automatically detects and displays Device 1-4.

Aptio Setup Utility - Copyright (C) 2011 American Megatrends, Inc.
Advanced

In case of multiple Option

Devicel Not Present ROMs (Fegacy and EFI
Device2 Not Present Compatible) , specifies what
Device3 Not Present PCI option ROM to lanuch.
Device4 Not Present

—<—: Select Screen

1|: Select Item
Enter: Select Item
+/-: Change Opt.

Fl: General Help

F2: Previous Values
F5: Optimized Defaults
F10: Save & Exit

ESC: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

4.4.6 PCI Subsystem Settings

Aptio Setup Utility - Copyright (C) 2011 American Megatrends, Inc.

Advanced
PCI Bus Driver Version V 2.05.00 In case of multiple Option
ROMs (Legacy and EFI
PCI Option ROM Handling Compatiple), specifies what
PCI ROM Priority [EFI Compatible ROM] PCI option ROM to lanuch.

PCI Common Settings

PCI Latency Timer [32 PCI Bus Clocks]
VGA Palette Snoop [Disabled]
PERR# Generation [Disabled]
SERR# Generation [Disabled]
Load RT32 Image [Enabled]

» PCI Express Settings

» PCIE Slot Option Rom Configuration —<: Select Screen
1l: Select Item

Enter: Select Item
+/-: Change Opt.

F1l: General Help

F2: Previous Values
F5: Optimized Defaults
F10: Save & Exit

19. Copyright (C) 2011 American Megatrends, Inc.
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PCI ROM Priority [EFI Compatible ROM]

In case of multiple option roms (Legacy and EFI Compatible), specifies what PCI
option rom to lanuch.Configuration options: [Legacy ROM] [EFI Compatible ROM]

PCI Latency Timer [32 PCI Bus Clocks]

The value is programmed into PCI latency timer register.

Configuration options: [32 PCI Bus Clocks] [64 PCI Bus Clocks] [96 PCI Bus Clocks]
[128 PCI Bus Clocks] [160 PCI Bus Clocks] [192 PCI Bus Clocks] [224 PCI Bus

Clocks] [248 PCI Bus Clocks]

VGA Palette Snoop [Disabled]

Enables or disables VGA pallette registers snooping.

Configuration options: [Disabled] [Enabled]

PERR# Generation [Disabled]

Enables or disables PCI device to generate PERR#.

Configuration options: [Disabled] [Enabled]

SERR# Generation [Disabled]

Enables or disables PCI device to generate SERR#.

Configuration options: [Disabled] [Enabled]

Load RT32 Image [Enabled]

Enables or disables RT32 image loading.
Configuration options: [Disabled] [Enabled]
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PCI Express Settings

Aptio Setup Utility - Copyright (C) 2011 American Megatrends, Inc.
Advanced

PCI Express Link Register Settings

ASPM Support [Disabled]
WARNING: Enabling ASPM may cause some
PCI-E device to fail

Enables or DisablesPCI
Express Device Relaxed
Ordering.

—<—: Select Screen

1l: Select Item
Enter: Select Item
+/-: Change Opt.

Fl: General Help

F2: Previous Values
F5: Optimized Defaults
F10: Save & Exit

ESC: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

PCI Express Link Register Settings
ASPM Support [Disabled]

Allows you to set the ASPM level.

Configuration options: [Disabled] [Auto] [Force LOs]
[Force LOs] Force all links to LOs state.

[Auto] BIOS auto configure.

[Disabled] Disabled ASPM.
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PCIE Slot Option Rom Configuration

Aptio Setup Utility - Copyright (C) 2011 American Megatrends, Inc.
Advanced

Legacy OpROM Support
Launch Storage OpROM

PCIEl Option Rom
PCIE2 Option Rom
PCIE3 Option Rom
PCIE4 Option Rom
PCIE5 Option Rom
PIKE Option Rom

[Enabled]

[Enabled]
[Enabled]
[Enabled]
[Enabled]
[Enabled]
[Enabled]

Enables or disables boot
option for legacy mass
storage device with
option ROM.

—<—: Select Screen

Tl: Select Item
Enter: Select Item
+/-: Change Opt.

Fl: General Help

F2: Previous Values
F5: Optimized Defaults
F10: Save & Exit

ESC: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

Launch Storage OpROM [Enabled]

Enables or disables boot option for legacy mass storage device with option ROM.

Configuration options: [Disabled] [Enabled]
PCIE1 Option Rom [Enabled]
Configuration options: [Disabled] [Enabled]
PCIE2 Option Rom [Enabled]
Configuration options: [Disabled] [Enabled]
PCIE3 Option Rom [Enabled]
Configuration options: [Disabled] [Enabled]
PCIE4 Option Rom [Enabled]
Configuration options: [Disabled] [Enabled]
PCIE5 Option Rom [Enabled]
Configuration options: [Disabled] [Enabled]

PIKE Option Rom [Enabled]
Configuration options: [Disabled] [Enabled]
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4.4.7 USB Configuration

Aptio Setup Utility - Copyright (C) 2011 American Megatrends, Inc.
Advanced

USB Configuration Enabled Legacy USB support.
AUTO option disables legacy

USB Devices: support if no USB devices

1 Drive, 2 Hubs are connected. DISABLE

option will keep USB devices

Legacy USB Support [Enabled] available only for EFI

EHCI Hand-off [Disabled] applications.

USB hardware delays and time-outs

USB transfer time-out [20 sec]

Device reset time-out [20 sec]

Mass Storage Devices:
» USB Ports Configuration —<: Select Screen
1l: Select Item
Enter: Select Item
+/-: Change Opt.
Fl: General Help
F2: Previous Values

F5: Optimized Defaults
F10: Save & Exit
ESC: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

Legacy USB Support [Enabled]

This item enables or disables Legacy USB device support.
Configuration options: [Enabled] [Disabled] [Auto]

EHCI Hand-off [Disabled]

This is a workaround for OSes without EHCI ownership change should be claimed
by EHCI driver.
Configuration options: [Disabled] [Enabled]

USB Hardware Delays and Time-outs

USB transfer time-out [20 sec]

This item sets the time-out value for control, bulk, and interrupt transfer.
Configuration options: [1 sec] [5 sec] [10 sec] [20 sec]

Device reset time-out [20 sec]

USB mass storage device Start Unit command time-out.
Configuration options: [10 sec] [20 sec] [30 sec] [40 sec]
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USB Ports Configuration

Aptio Setup Utility - Copyright (C) 2011 American Megatrends, Inc.
Advanced

USB
USB
USB
USB
USB
USB
USB
USB
USB
USB
USB
USB
USB
USB

Port
Port
Port
Port
Port
Port
Port
Port
Port
Port
Port
Port
Port
Port

EHCI Controller 1
EHCI Controller 2

[Enabled]
[Enabled]

[Enabled]
[Enabled]
[Enabled]
[Enabled]
[Enabled]
[Enabled]
[Enabled]
[Enabled]
[Enabled]
[Enabled]
[Enabled]
[Enabled]
[Enabled]
[Enabled]

Enable/Disable (EHCI
Support.

—<: Select Screen

tl: Select Item
Enter: Select Item
+/-: Change Opt.

Fl: General Help

F2: Previous Values
F5: Optimized Defaults
F10: Save & Exit

ESC: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

EHCI Controller 1/2 [Enabled]

Allows you to enable or disable USB 2.0 (EHCI) Support. If we disable the EHCI
Controller in BIOS > South Bridge > USB configuration, the USB device will all

disable in OS.
Configuration options: [Disabled] [Enabled]

USB Port 1/2/ 3/ 4/ 5/ 6/ 7/ 8/ 9/ 10/ 11/ 12/ 13/ 14 [Enabled]

Allows you to enable or disable USB ports.
Configuration options: [Disabled] [Enabled]

4.4.8

Trusted Computing

Aptio Setup Utility - Copyright (C) 2011 American Megatrends, Inc.
Advanced

Configuration
TPM SUPPORT

Current Status Information
No Security Device Found

[Enabled]

Enables or Disables BIOS
support for security device.
0.S. will not show Security
Device. TCG EFI protocol and
INT1A interface will not be
available.

TPM SUPPORT [Enabled]
Allows you to enable or disable the TPM support.
Configuration options: [Disabled] [Enabled]
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4.4.9 ACPI Settings

Aptio Setup Utility - Copyright (C) 2011 American Megatrends, Inc.
Advanced

ACPI Settings Enables or Disables BIOS ACPI|
Auto Configuration.

Enable ACPI Auto Configuration [Disabled]
Enabled Hibernation [Enabled]
ACPI Sleep State [S1 (CPU Stop Clock)]
Lock Legacy Resources [Disabled]

Enable ACPI Auto Configuration [Disabled]

Allows you to enable or disable BIOS ACPI Auto Configuration.
Configuration options: [Disabled] [Enabled]

The following item appears only when you set Enabled ACPI Auto
Configuration to [Disabled].

Enable Hibernation [Enabled]

Enables or disables system ability to Hibernate (0S/S4 sleep state). This option
may be not effective with some OS.

Configuration options: [Disabled] [Enabled]

ACPI Sleep State [S1 (CPU Stop Clock)]

Allows you to set the ACPI Sleep State.

Configuration options: [Suspend Disabled] [S1 (CPU Stop Clock)] [S3 (Suspend to
RAM)]

Lock Legacy Resources [Disabled]

Allows you to enable or disable Lock Legacy Resources.
Configuration options: [Disabled] [Enabled)]
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4410 WHEA Configuration

Aptio Setup Utility - Copyright (C) 2011 American Megatrends, Inc.
Advanced

WHEA Support [Enabled] Enable or disable Windows
Hardware Error Architecture.

WHEA Support [Enabled]

Allows you to enable or disable the Windows Hardware Error Architecture support.
Configuration options: [Disabled] [Enabled]

4.411 APM setting

Aptio Setup Utility - Copyright (C) 2011 American Megatrends, Inc.
Advanced

Restore AC Power Loss [Last State] Specify what state to go to
Power On By PCIE [Disabled] when power is re-applied after]
Power On By Ring [Disabled] a power failure (G3 state).
Power On By RTC [Disabled]

Restore AC Power Loss [Last State]

When set to [Power Off], the system goes into off state after an AC power loss.
When set to [Power On], the system will reboot after an AC power loss. When set
to [Last State], the system goes into either off or on state, whatever the system
state was before the AC power loss.

Configuration options: [Power Off] [Power On] [Last State]

Power On By PCIE [Disabled]

[Disabled] Disables the PCIE devices from generating a wake event.
[Enabled] Enables the PCIE devices to generate a wake event.
Power On By Ring [Disabled]

[Disabled] Disables the Ring devices from generating a wake event.
[Enabled] Enables the Ring devices to generate a wake event.
Power On By RTC [Disabled]

[Disabled] Disables RTC from generating a wake event.

[Enabled] When set to [Eanbled], the items RTC Alarm Date (Days) and
Hour/Minute/Second will become user-configurable with set
values.
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4.4.12 Serial Port Console Redirection

Aptio Setup Utility - Copyright (C) 2011 American Megatrends, Inc.
Advanced

CcoM1 Consloe Redirection Enable
Console Redirection [Disabled] or Disable.
P Console Redirection Settings

COM2
Console Redirection [Enabled]
p Console Redirection Settings

Serial Port for Out-of-Band Management/
Windows Emergency Management Services (EMS)
Console Redirection [Disabled] —><: Select Screen
» Console Redirection Settings }): Select Item
Enter: Select Item
+/-: Change Opt.
Fl: General Help
F2: Previous Values
F5: Optimized Defaults
F10: Save & Exit
ESC: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

cowm1
Console Redirection [Disabled]

Enables or disables the console redirection feature.
Configuration options: [Disabled] [Enabled)]

% The following item appears only when you set Console Redirection to
[Enabled].

Console Redirection Settings

This item becomes configurable only when you enable the Console Redirection
item. The settings specify how the host computer and the remote computer (which
the user is using) will exchange data. Both computers should have the same or
compatible settings.

Terminal Type [VT-UTF8]

Allows you to set the terminal type.

[VT100] ASCII char set.

[VT1004] Extends VT100 to support color, function keys, et.

[VT-UTF8] Uses UTF8 encoding to map Unicode chars onto 1 or more bytes

[ANSI]  Extended ASCII char set

Bits per second [57600]

Selects serial port transmission speed. The speed must be matched on the

other side. Long or noisy lines may require lower speeds.
Configuration options: [9600] [19200] [38400] [57600] [115200]
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Data Bits [8]
Configuration options: [7] [8]

Parity [None]

A parity bit can be sent with the data bits to detect some transmission errors.
[Mark] and [Space] parity do not allow for error detection.

[None]  No parity bit

[Even]  parity bitis O if the num of 1’s in the data bits is even

[Odd] parity bit is 0 if num of 1’s in the data bits is odd

[Mark] parity bit is always 1

[Space] parity bit is always O

Stop Bits [1]

Stop bits indicate the end of a serial data packet. (A start bit indicates the
beginning.) The standard setting is 1 stop bit. Communication with slow
devices may require more than 1 stop bit. Configuration options: [1] [2]

Flow Control [Hardware RTS/CTS]

Flow control can prevent data loss from buffer overflow. When sending data,
if the receiving buffers are full, a “stop” signal can be sent to stop the data
flow. Once the buffers are empty, a “start” signal can be sent to re-start the
flow. Hardware flow control uses two wires to send start/stop signals.
Configuration options: [None] [Hardware RTS/CTS]

Recorder Mode [Disabled]
With this mode enabled only text will be sent. This is to capture Terminal data.
Configuration options: [Disabled] [Enabled]

Legacy OS Redirection Resolution [80x24]
Configures the number of rows and columns supported on legacy OS.
Configuration options: [80x24] [80x25]

COom2
Console Redirection [Enabled]

Enables or disables the console redirection feature.
Configuration options: [Disabled] [Enabled]
Console Redirection Settings

Please refer to the description of the Console Redirection Settings item under
COM1 for details.
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Serial Port for Out-of-Band Management/ Windows Emergency
Management Services (EMS)

Console Redirection [Disabled]
Enables or disables the console redirection feature.
Configuration options: [Disabled] [Enabled]

The following item appears only when you set Console Redirection to
[Enabled].

Console Redirection Settings

Out-of-Band Mgmt Port [COM1]

Microsoft Windows Emergency Management Services (EMS) allow for
remote management of a Windows Server OS through a serial port.
Configuration options: [COM1] [COM2]

Terminal Type [VT-UTF8]

Microsoft Windows Emergency Management Services (EMS) allow for
remote management of a Windows Server OS through a serial port.
Configuration options: [VT100] [VT100+] [VT-UTF8] [ANSI]

Bits per second [115200]

Microsoft Windows Emergency Management Services (EMS) allow for
remote management of a Windows Server OS through a serial port.
Configuration options: [9600] [19200] [57600] [115200]

Flow Control [None]

Microsoft Windows Emergency Management Services (EMS) allow for
remote management of a Windows Server OS through a serial port.
Configuration options: [None] [Hardware RTS/CTS] [Software Xon/Xoff]
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4.413 Onboard LAN Configuration

Aptio Setup Utility - Copyright (C) 2011 American Megatrends, Inc.
Advanced

Onboard LAN Configuration Launch INTEL W82574L OpROM
INTEL W82574L OpROM1 [PXE]
INTEL W82574L OpROM2 [PXE]

INTEL W82574L OpROM1 [PXE]
This item launched INTEL W82574L OpROM1.
Configuration options: [Disabled] [PXE] [iSCSI]

INTEL W82574L OpROM2 [PXE]
This item launched INTEL W82574L OpROM2.
Configuration options: [Disabled] [PXE] [iSCSI]

4414 ME Subsystem

Aptio Setup Utility - Copyright (C) 2011 American Megatrends, Inc.
Advanced

Intel ME Subsystem Configuration ME Subsystem Help.

ME BIOS Interface Version L2

ME Version Aotk 8oV

ME FW Status Value : 0x£0345

ME FW State 8 SPS ME FW Active

ME FW Operation State: MO without UMA

ME FW Error Code: No Error

ME Ext FW Status value: 0x3900a101

BIOS Booting Mode: Performance Optimized

Cores Disabled: 0

ME FW SKU Information: SiEn —<: Select Screen
1l: Select Item
Enter: Select Item
+/-: Change Opt.
Fl: General Help
F2: Previous Values
F5: Optimized Defaults
F10: Save & Exit
ESC: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.
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4.4.15 Onboard Devices Configuration

Aptio Setup Utility - Copyright (C) 2011 American Megatrends, Inc.

Advanced
» Serial Port 1 Configuration Set Parameters of serial
» Serial Port 2 Configuration Port 1(COM1).

Serial Port 1/2 Configuration

Aptio Setup Utility - Copyright (C) 2011 American Megatrends, Inc.
Advanced

Serial Port Configuration Enable or Disable Serial
Port (COM) .

Serial Port [Enabled]

Device Settings I0=3F8h; IRQ=4

Device Mode [Standard Serial Po...]

Serial Port [Enabled]

Allows you to enable or disable the serial port.
Configuration options: [Disabled] [Enabled]

Device Mode [Standard Serial Port Mode]

Allows you to change the serial port mode.
Configuration options: [Standard Serial Port Mode]

4416 Runtime Error Logging

Aptio Setup Utility - Copyright (C) 2011 American Megatrends, Inc.
Advanced

Runtime Error Logging Support [Disabled]

Runtime Error Logging Support [Disabled]

This item allows you to enable or disable Runtime Error Logging Support.
Configuration options: [Disabled] [Enabled)]

The following item appears only when you set Runtime Error Logging Support
to [Enabled].

PCI Error Logging Support [Disabled]

Allows you to enable or disable PCI Error Logging.
Configuration options: [Disabled] [Enabled].
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4.5 Server Mgmt menu

The Server Mgmt menu displays the server mgmt status, and allows you to change
the settings.

The Server Mgmt menu appears only when you install ASMB card on the
motherboard.

Aptio Setup Utility - Copyright (C) 2011 American Megatrends, Inc.

Main Advanced [ESRYe 8 Event Logs Boot Monitor Security Tool Exit

BMC Firmware: X.XX Wait for BMC response for
specified timeout In PILOTII,
BMC starts at the same time
0/S Watchdog Timer [Disabled] when BIOS starts during AC
0/S Wtd Timer Timeout [10 minutes] power ON. It takes arround
0/S Wtd Timer Policy [Reset] 30 seconds to initialize
Host to BMC interfaces.

» System Event Log

» BMC network configuration

—<: Select Screen

Ml: Select Item
Enter: Select Item
+/-: Change Opt.

Fl: General Help

F2: Previous Values
F5: Optimized Defaults
F10: Save & Exit

ESC: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

0/S Watchdog Timer [Disabled]

If enabled, starts a BIOS timer which can only be shut off by Intel Management
Software after the OS loads. Helps determine that the OS sucessfully loaded or
follows the O/S Boot Watchdog Timer Policy.

Configuration options: [Enabled] [Disabled]

0/S Wid Timer Timeout [10 minutes]

Allows you to configure the length of the O/S Boot Watchdog Timer. Not available if
0/S Boot Watchdog Timer is disabled.
Configuration options: [5 minutes] [10 minutes] [15 minutes] [20 minutes]

0/S Wtd Timer Policy [Reset]

Allows you to configure how the system should respond if the OS Boot Watchdog
Timer expires. Not available if O/S Boot Watchdog Timer is disabled.
Configuration options: [Do Nothing] [Reset] [Power Down]

Chapter 4: BIOS setup



4.5.1 System Event Log

Aptio Setup Utility - Copyright (C) 2011 American Megatrends, Inc.
Server Mgmt

Enabling/Disabling Options Change this to enable or
disable all features of

SEL Components [Disabled] system Event Logging during
boot.

Erasing Settings

Erase SEL [No]

When SEL is Full [Do Nothing]

Note: All values changed here do not take effect —<: Select Screen

until computer is restarted. 1l: Select Item

Enter: Select Item
+/-: Change Opt.

F1l: General Help

F2: Previous Values
F5: Optimized Defaults
F10: Save & Exit

ESC: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

SEL Components [Disabled]

Allows you to enable or disable all features of system Event Logging during boot.
Configuration options: [Disabled] [Enabled]

+  The following items appears only when you set SEL Components to
[Enabled].

+ Al values changed here do not take effect until computer is restarted.

Erase SEL [No]

Allows you to choose options for erasing SEL.
Configuration options: [No] [Yes, On next reset] [Yes, On every reset]

When SEL is Full [Do Nothing]

Allows you to choose options for reactions to a full SEL.
Configuration options: [Do Nothing] [Erase Immediately]
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4.5.2 BMC network configuration

Aptio Setup Utility - Copyright (C) 2011 American Megatrends, Inc.
Server Mgmt

BMC network configuration Select to configure LAN
channel parameters

Eant statically or dynamically (by
Lanl IP Address in BMC: 000.000.000.000 BIOS or BMC). Unspecified
Lanl Subnet Mask in BMC: 000.000.000.000 option will not modify any
Lanl Gateway Address in BMC: 000.000.000.000 BMC network parameters

Lanl MAC Address in BMC: 00.00.00.00.00.00 during BIOS phase

Lanl Address Source in BMC: Static Mode

Configuration Address source [Previous State]

—<—: Select Screen

1}: Select Item
Enter: Select Item
+/-: Change Opt.

Fl: General Help

F2: Previous Values
F5: Optimized Defaults
F10: Save & Exit

ESC: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

Configuration Address source [Previous State]

Select to configure LAN channel parameters statically or dynamically (by BIOS
or BMC). Unspecified option will not modify any BMC network parameters during
BIOS phase.

Configuration options: [Previous State] [Static Mode] [DHCP Mode]

The following items appears only when you set Configuration Address source
to [Static Mode].

Station IP address [0.0.0.0]
Allows to input Station IP address.

Subnet mask [0.0.0.0]
Allows to input Subnet mask.

Gateway IP address [0.0.0.0]
Allows to input Gateway IP address.
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4.6 Event Logs menu

The Event Logs allows you to change or view the event log settings.

Aptio Setup Utility - Copyright (C) 2011 American Megatrends, Inc.

Main Advanced Server Mgmt PHRSAMRFEY Boot Monitor Security Tool Exit

» Change Smbios Event Log Settings Press <Enter> to change
the Smbios Event Log
View Smbios Event Log configuration.

View System Event Log

—<—: Select Screen

1l: Select Item
Enter: Select Item
+/-: Change Opt.

Fl: General Help

F2: Previous Values
F5: Optimized Defaults
F10: Save & Exit

ESC: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

4.6.1 Change Smbios Event Log Settings

Press <Enter> to change the Smbios Event Log configuration.
Aptio Setup Utility - Copyright (C) 2011 American Megatrends, Inc.

Event Logs
Enabling/Disabling Options Change this to enable or
5 disable all features of
Smbios Event Log [Enabled] Smbios Event Logging during
Erasing Settings L2
Erase Event Log [No]
When Log is Full [Do Nothing]
Smbios Event Log Standard Settings
Log System Boot Event [Disabled] < Select Screen
ﬁ% 20 1l: Select Item
Enter: Select Item

. +/-: Change Opt.
CESEE EREen Fl: General Help
Log OEM Codes [Enabled] F2: Previous Values
Convert OEM Codes [Disabled] F5: Optimized Defaults
Note: All values changed here do not take effect F10: Save & Exit

until computer is restarted. ESC: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

All values changed here do not take effect until computer is restarted.

AN

Enabling/Disabling Options

Smbios Event Log [Enabled]

Change this to enable or disable all features of Smbios Event Logging during
boot.Configuration options: [Disabled] [Enabled]

Erasing Settings
Erase Event Log [No]

Choose options for erasing Smbios Event Log. Erasing is done prior to any
logging activation during reset.
Configuration options: [No] [Yes, Next reset] [Yes, Every reset]
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When Log is Full [Do Nothing]
Allows you to choose options for reactions to a full Smbios Event Log.
Configuration options: [Do Nothing] [Erase Immediately]

Smbios Event Log Standard Settings

Log System Boot Event [Disabled]

Allows you to choose options to enable/disable logging of System boot event.
Configuration options: [Enabled] [Disabled]

MECI [1]

Mutiple Event Count Increment (MECI). The number of occurrences of a
duplicate event that must pass before the multiplt-event counter associated
with the log entry is updated, specified as a numeric value in the range 1 to
255.

METW [60]

Mutiple Event Time Windows (METW). The number of minutes which must
pass between duplicate log entries which utilize a multiple-event counter. The
value ranges from 0 to 99 minutes.

Custom QOptions
Log OEM Codes [Enabled]

Enable or disable the logging of EFI Status Codes as OEM Codes (if not
already converted to legacy).
Configuration options: [Disabled] [Enabled]

Convert OEM Codes [Disabled]

Enable or disable the converting of EFI Status Codes to Standard Smbios
Types (Not all may be translated).

Configuration options: [Disabled] [Enabled]

View Smbios Event Log
Press <Enter> to view all smbios event logs.

View System Event Log
Press <Enter> to view all system event logs.
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4.7 Boot menu

The Boot menu items allow you to change the system boot options.
Aptio Setup Utility - Copyright (C) 2011 American Megatrends, Inc.

Main Advanced Server Mgmt Event Logs Q:llJd Monitor Security Tool Exit

Boot Configuration Number of seconds to wait for

SOiAfD BEeTes TRhrei 1 setup activation key.
ECCEUFRNURICCERSEa S Lol 65535 (0xFFEF) means indefinite
waiting.
Full Screen Logo [Enabled]
CSM16 Module Version 07.68
GateA20 Active [Upon Request]
Option ROM Messages [Force BIOS]
Interrupt 19 Capture [Enabled]
Boot Device Seeking [Endless PXE]
UEFI Boot [Disabled]
Boot Option Priorities —><: Select Screen
Boot Option #1 [IBA GE Slot 0600 v...] 1l: Select Item
Boot Option #2 [AMI Virtual Floppy...] E?t?réhiﬁézcgpitem
Floppy Drive BBS Priorities Fl: General Help
Network Device BBS Priorities F2: Previous Values
CD/DVD ROM Drive BBS Priorities F5: Optimized Defaults
Hard Drive BBS Priorities F10: Save & Exit
ESC: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

Setup Prompt Timeout [xx]

Use the <+> and <-> keys to adjust the number of seconds to wait for setup
activation key.

Bootup NumLock State [On]

Allows you to select the power-on state for the NumLock.

Configuration options: [Off] [On]

Full Screen Logo [Enabled]

Allows you to enable or disable the full screen logo display feature.
Configuration options: [Disabled] [Enabled]

% Set this item to [Enabled] to use the ASUS MyLogo2™ feature.

CSM16 Module Version
GateA20 Active [Upon Request]
[Upon Request] GA20 can be disabled using BIOS services.

[Always] Do not allow disable GA20; this optionis useful when any RT code
is executed above 1MB.

Option ROM Messages [Force BIOS]

Allows you to set the display mode for Options ROM.
Configuration options: [Force BIOS] [Keep Current]
Interrupt 19 Capture [Enabled]

Allows Option ROMs to trap interrupt 19.
Configuration options: [Disabled] [Enabled]
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Boot Device Seeking [Endless PXE]

[Endless PXE] Continuous seek remote boot image until boot image found or user
abort (press Ctrl+Alt+Del).

[Normal] Seek remote boot image once then stop.

UEFI Boot [Disabled]

Enables or disables UEFI Boot.
Configuration options: [Disabled] [Enabled]

Boot Option Priorities

These items specify the boot device priority sequence from the available devices.
The number of device items that appears on the screen depends on the number of
devices installed in the system.

+  To select the boot device during system startup, press <F8>when ASUS
Logo appears.

To access Windows OS in Safe Mode, please press <F8> after POST.

Set the booting order of network devices.

Boot Option #1/#2/#3/#4 [SATA P2:ASUS ...]
Configuration options: [SATA P2: ASUS ...][SATA P3: WDC WD&0...]
[AMI Virtual Floppy...] [IBA GE Slot 0700 v...]

CD/DVD ROM Drive BBS Priorities

Hard Drive BBS Priorities

Floppy Drive BBS Priorities

Network Device BBS Priorities

These items appear only when you connect SATA ODD or hard drive to the
SATA ports and allow you to set the booting order of the SATA devices.
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4.8 Monitor menu

The Monitor menu displays the system temperature/power status, and allows you
to change the fan settings.

Aptio Setup Utility - Copyright (C) 2011 American Megatrends, Inc.

Main Advanced Server Mgmt Event Logs Boot RIGLERZSSE Security Tool Exit

CPUl Temperature 53.2°C/127.4°F A

CPU2 Temperature N/A

TR1 Temperature 35.1°C/95.3°F

TR2 Temperature 36.3°C/97.3°F

CPU FAN1 Speed 5133 RPM

CPU FAN2 Speed N/A

FRNT FAN1 Speed N/A

FRNT FAN2 Speed N/A

FRNT FAN3 Speed N/A

FRNT FAN4 Speed N/A

REAR FAN1 Speed N/A

REAR FAN2 Speed N/A

+VTT_CPU +1.060V

VCORE1 +1.056V

VCORE2 N/A

+VDDQ_CPUL N/A —<—: Select Screen

+VDDQ_CPU2 N/A 1l: Select Item

+5VSB +4.966V Enter: Select Item

+5V +4.979V +/-: Change Opt.

+12v +11.712v Fl: General Help

+3.3V +3.264V F2: Previous Values

VBAT +3.282V F5: Optimized Defaults

+3.3VSB +3.270V F10: Save & Exit
ESC: Exit

FAN Speed Control [Generic Mode]

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

CPU 1/2; TR1 1/2 Temperature [xxx°C/xxx°F]
The onboard hardware monitor automatically detects and displays the CPU and
motherboard component temperatures.

CPU FAN1/2 Speed; FRNT FAN1-4 Speed; REAR FAN1/2 Speed
[xxxx RPM] or [N/A]

The onboard hardware monitor automatically detects and displays the speed of
CPU fans, front fans, and rear fan in rotations per minute (RPM). If the fan is not
connected to the motherboard, the field shows N/A.

+VTT_CPU Voltage, VCORE1/2 Voltage, +VDDQ_CPU1 Voltage,
+VDDQ_CPU2 Voltage, +5VSB Voltage, +5V Voltage, +12V Voltage,
+3.3V Voltage, VBAT Voltage, +3.3VSB Voltage

The onboard hardware monitor automatically detects the voltage output through
the onboard voltage regulators.

FAN Speed Control [Generic Mode]

Allows you to configure the ASUS Smart Fan feature that smartly adjusts the fan
speeds for more efficient system operation.
Configuration options: [Generic Mode] [High Speed Mode] [Full Speed Mode]
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4.9 Security menu

The Security menu items allow you to change the system security settings.
Aptio Setup Utility - Copyright (C) 2011 American Megatrends, Inc.

Main Advanced Server Mgmt Event Logs Boot Monitor [ECiSESd Tool Exit

Password Description Set Setup Administrator
Password

If ONLY the Administrator's password is set,

then this only limits access to Setup and is

only asked for when entering Setup

If ONLY the User's password is set, then this

is a power on password and must be entered to

boot or enter Setup. In Setup the User will

have Administrator rights

The password length must br in the following range:
Minimum length S

Maximum length 20

Administrator Password
User Password

If you have forgotten your BIOS password, erase the CMOS Real Time
Clock (RTC) RAM to clear the BIOS password. See section 2.6 Jumpers for
information on how to erase the RTC RAM.

Administrator Password

If you have set an administrator password, we recommend that you enter the
administrator password for accessing the system. Otherwise, you might be able to
see or change only selected fields in the BIOS setup program.

To set an administrator password:

1. Select the Administrator Password item and press <Enter>.

2. From the Create New Password box, key in a password, then press
<Enter>.

3. Confirm the password when prompted.
To change an administrator password:
1. Select the Administrator Password item and press <Enter>.

2. From the Enter Current Password box, key in the current password, then
press <Enter>.

3. From the Create New Password box, key in a new password, then press
<Enter>.

4. Confirm the password when prompted.

To clear the administrator password, follow the same steps as in changing an
administrator password, but press <Enter> when prompted to create/confirm the
password.
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User Password

If you have set a user password, you must enter the user password for accessing
the system.

To set a user password:

1. Select the User Password item and press <Enter>.

2. From the Create New Password box, key in a password, then press
<Enter>.

3. Confirm the password when prompted.

To change a user password:
1. Select the User Password item and press <Enter>.

2. From the Enter Current Password box, key in the current password, then
press <Enter>.

3.  From the Create New Password box, key in a new password, then press
<Enter>.

4. Confirm the password when prompted.

To clear the user password, follow the same steps as in changing a user password,
but press <Enter> when prompted to create/confirm the password.

4.10 Tool menu

The Tool menu items allow you to configure options for special functions. Select an
item then press <Enter> to display the submenu.

Aptio Setup Utility - Copyright (C) 2011 American Megatrends, Inc.

Main Advanced Server Mgmt Event Logs Boot Monitor Security RilI§ Exit

Be used to update BIOS
ASUS EZ Flash 2 Utility

ASUS EZ Flash 2 Utility

Allows you to run ASUS EZ Flash BIOS ROM Utility when you press <Enter>.
Check section 4.1.2 ASUS EZ Flash 2 Utility for details.
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4.11 Exit menu

The Exit menu items allow you to save or discard your changes to the BIOS items.

Aptio Setup Utility - Copyright (C) 2011 American Megatrends, Inc.

Main Advanced Server Mgmt Event Logs Boot Monitor Security Tool RB»3R4

Discard Changes & Exit Exit system setup without
Save Changes & Reset saving any changes.
Discard Changes & Reset

Restore Defaults

Boot Override

AMI Virtual FloppyO 1.00
IBA GE Slot 0600 v1376
IBA GE Slot 0700 v1376

Launch EFI Shell from filesystem device

—<—: Select Screen

t]l: Select Item
Enter: Select Item
+/-: Change Opt.

Fl: General Help

F2: Previous Values
F5: Optimized Defaults
F10: Save & Exit

ESC: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.

Pressing <Esc> does not immediately exit this menu. Select one of the options
from this menu or <F10> from the legend bar to exit.

Discard Changes & Exit

This option allows you to exit the Setup program without saving your changes.
When you select this option or if you press <Esc>, a confirmation window appears.
Select Yes to discard changes and exit.

Save Changes & Reset

Once you are finished making your selections, choose this option from the Exit
menu to ensure the values you selected are saved. When you select this option or
if you press <F10>, a confirmation window appears. Select Yes to save changes
and exit.

Discard Changes & Reset

This option allows you to reset the Setup program without saving your changes.
When you select this option, a confirmation window appears. Select Yes to discard
changes and reset.

Restore Defaults

This option allows you to restore/load defaults values for all the setup options.
When you select this option or if you press <F5>, a confirmation window appears.
Select Yes to load optimized defaults.
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Boot Override

These items displays the available devices. The device items that appears on the
screen depends on the number of devices installed in the system. Click an item to
start booting from the selected device.

Launch EFI Shell from filesystem device

This item is for launching the EFI Shell application from one of the available
filesystem devices.

ASUS Z9NA-D6
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This chapter provides instructions for
setting up, creating, and configuring RAID
sets using the available utilities.

RAID
configuration



5.1
5.2
53

5.4

Setting up RAID.......ccocrcrceirs s 5-3
LSI Software RAID Configuration ULility .........ceemmmnssnsnsnnnns 5-5
Intel® Rapid Storage Technology enterprise SCU/SATA

Option ROM ULIlity .....ccocrerermscsssmenesssssssessssssssesssssssssessssssssessns 5-25
Intel® Rapid Storage Technology enterprise Utility

(WINAOWS) ...eerecerrerneessessssessssessesssssssssssssssssssssssssssssssssssssssssssnssnes 5-35
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5.1 Setting up RAID

The motherboard supports the following RAID solutions:

. LSI MegaRAID software RAID Configuration Utility with RAID 0, RAID 1,
and RAID 10 support (for both Linux and Windows OS).

. Intel Rapid Storage Technology enterprise SCU / SATA Option ROM
Utility with RAID 0, RAID 1, RAID 10, and RAID 5 support (for Windows OS
only).

5.1.1 RAID definitions

RAID 0 (Data striping) optimizes two identical hard disk drives to read and write
data in parallel, interleaved stacks. Two hard disks perform the same work as a
single drive but at a sustained data transfer rate, double that of a single disk alone,
thus improving data access and storage. Use of two new identical hard disk drives
is required for this setup.

RAID 1 (Data mirroring) copies and maintains an identical image of data from one
drive to a second drive. If one drive fails, the disk array management software
directs all applications to the surviving drive as it contains a complete copy of

the data in the other drive. This RAID configuration provides data protection and
increases fault tolerance to the entire system. Use two new drives or use an
existing drive and a new drive for this setup. The new drive must be of the same
size or larger than the existing drive.

RAID 1E (Enhanced RAID 1) has a striped layout with each stripe unit having a
secondary (or alternate) copy stored on a different disk. You can use three or more
hard disk drives for this configuration.

RAID 10 is data striping and data mirroring combined without parity (redundancy

data) having to be calculated and written. With the RAID 10 configuration you get
all the benefits of both RAID 0 and RAID 1 configurations. Use four new hard disk
drives or use an existing drive and three new drives for this setup.

RAID 5 stripes both data and parity information across three or more hard disk
drives. Among the advantages of RAID 5 configuration include better HDD
performance, fault tolerance, and higher storage capacity. The RAID 5 configuration
is best suited for transaction processing, relational database applications,
enterprise resource planning, and other business systems. Use a minimum of three
identical hard disk drives for this setup.

R + If you want to boot the system from a hard disk drive included in a created
RAID set, copy first the RAID driver from the support DVD to a floppy disk
before you install an operating system to the selected hard disk drive.

Please refer to chapter 2 for how to select the RAID configuration utility.
Move the jumper to choose between LSI MegaRAID and Intel® Rapid RAID.
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5.1.2 Installing hard disk drives

The motherboard supports Serial ATA for RAID set configuration. For optimal
performance, install identical drives of the same model and capacity when creating
a disk array.

To install the SATA hard disks for RAID configuration:

1. Install the SATA hard disks into the drive bays following the instructions in the
system user guide.

2. Connect a SATA signal cable to the signal connector at the back of each drive
and to the SATA connector on the motherboard.

3. Connect a SATA power cable to the power connector on each drive.

5.1.3 Setting the RAID item in BIOS

You must set the RAID item in the BIOS Setup before you can create a RAID set
from SATA hard disk drives attached to the SATA connectors supported by
Intel® C602 chipset. To do this:

Enter the BIOS Setup during POST.

Go to the Advanced Menu > PCH SATA Configuration, then press <Enter>.
Set SATA Mode to [RAID Mode]

Press <F10> to save your changes and exit the BIOS Setup.

El

R Refer to Chapter 4 for details on entering and navigating through the BIOS
Setup.

514 RAID configuration utilities

Depending on the RAID connectors that you use, you can create a RAID set using
the utilities embedded in each RAID controller. For example, use the LSI Software
RAID Configuration Utility or the Intel® Rapid Storage Technology if you
installed Serial ATA hard disk drives on the Serial ATA connectors supported by the
Intel® C602 chipset.

Refer to the succeeding section for details on how to use the RAID configuration
utility.
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5.2 LSI Software RAID Configuration Utility

The LSI MegaRAID software RAID configuration utility allows you to create RAID 0,
RAID 1, or RAID 10 set(s) from SATA hard disk drives connected to the SATA
connectors supported by the motherboard southbridge chip.

To enter the LS| MegaRAID software RAID configuration utility:

. Turn on the system after installing all the SATA hard disk drives.
2. During POST, the LS| MegaRAID software RAID configuration utility
automatically detects the installed SATA hard disk drives and displays any
existing RAID set(s). Press <Ctrl> + <M> to enter the utility.

LSI MegaRAID Software RAID BIOS Version A.10 09231523R
LSI SATA RAID Found at PCI Bus No:00 Dev No:1lF
Device present at Port 0 ST3160812AS 152114MB

Device present at Port 1 ST3160812AS 152114MB
Device present at Port 2 ST3160812AS 152114MB
Device present at Port 3 ST3160812AS 152114MB
Press Ctrl-M or Enter to run LSI Software RAID Setup Utility.

*  The LSI MegaRAID software RAID configuration utility automatically
configures to RAID 1 when the SATA to RAID Mode is enabled.

+  The RAID setup screens shown in this section are for reference only and
may not exactly match the items on your screen due to the controller
version difference.

When you create RAID sets with the LS| MegaRAID software RAID
configuration utility, the boot priority of the SATA optical drive has to be
manually adjusted. Otherwise, the system will not boot from the connected
SATA ODD.

3. The utility main window appears. Use the arrow keys to select an option from
the Management Menu and then press <Enter>. Refer to the Management
Menu descriptions on the next page.

At the bottom of the screen is the legend box. The keys on the legend box
allow you to navigate through the setup menu options or execute commands.
The keys on the legend box vary according to the menu level.

LSI Software RAID Configuration Utility Ver C.05 Sep 17, 2010
BIOS Version A.10.09231523R

Management Menu

Initialize
Objects

Rebuild

Check Consistenc

Use Cursor Keys to Navigate Between Items And Press Enter To Select An Option
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Menu Description

Configure Allows you to create RAID 0, RAID 1 or RAID 10 set using the Easy
Configuration or the New Configuration command. This menu also
allows you to view, add, or clear RAID configurations or select the

boot drive
Initialize Allows you to initialize the virtual drives of a created RAID set
Objects Allows you to initialize virtual drives or change the virtual drive
parameters
Rebuild Allows you to rebuild failed drives

Check Consistency | Allows you to check the data consistency of the virtual drives of a
created RAID set

5.2.1 Creating a RAID set

The LSI Software RAID Configuration Utility allows you to create a RAID 0, RAID
1, or RAID 10 set using two types of configurations: Easy and New.

In Easy Configuration, the virtual drive parameters are set automatically.

In New Configuration, you manually set the virtual drive parameters.

Using Easy Configuration

To create a RAID set using the Easy Configuration option:

1. From the Management Menu, select Configure > Easy Configuration, and
then press <Enter>.

LSI Software RAID Configuration Utility Ver C.05 Sep 17, 2010
BIOS Version A.10.09231523R

Configuration Menu-
Management |New Configuration
View/Add Configuration
Initialize Clear Configuration
j Select Boot Drive

Check Consistency

Defines Physical Arrays. An Array Will Automatically Become A VD

Use Cursor Keys to Navigate Between Items And Press Enter To Select An Option

Chapter 5: RAID configuration



The ARRAY SELECTION MENU displays the available drives connected to
the SATA ports. Use the up/down arrow keys to select the drives you want to
include in the RAID set, and then press <Space>. When selected, the drive
indicator changes from READY to ONLIN A[X]-[Y], where X is the array
number, and Y is the drive number.

LSI Software RAID Configuration Utility Ver C.05 Sep 17, 2010
BIOS Version A.10.09231523R

Easy Configuration - ARRAY SELECTION MENU-

Management
[Configure
Initialize ONLIN A00-00
Objects
Rebuild ONLIN A00-01
Check Consist v

READY

Port # 2 DISK 74.74GB  HDS728080PLA380 05.01C05]

SPACE-Sel ,ENTER-EndArray,F10-Configure,F2-Drive Info,F3-Virtual Drives,F4-HSP

R +  The information of the selected hard disk drive displays at the bottom of the

3.

4.

screen.
+  You need at least two identical hard disk drives when creating a RAID 1 set.

+  You need at least four identical hard disk drives when creating a RAID 10
set.

Select all the drives required for the RAID set, and then press <F10> to
configure array setting.

Press <Space> to select the configurable array.

LSI Software RAID Configuration Utility Ver C.05 Sep 17, 2010
BIOS Version A.10.09231523R

Easy Configuration - ARRAY SELECTION MENU———

Management Select Configurable Array (s
g

Initialize
Objects

Rebuild
Check Consist

Cursor Keys, SPACE-(De)Select F2-ChIdInfo F3-SlotInfo F10-Configure Esc-Quit
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5.

6.
7.

Press <F10> again, the virtual drive information appears including a Virtual
Drive menu that allows you to change the virtual drive parameters.

LSI Software RAID Configuration Utility Ver C.05 Sep 17, 2010
Virtual Drive(s) Configured:
#Stripes

StripSz

148.580GB 2 64 KB
Initializ
Objects
Rebuild
Check Cor
Virtual Drive 0

RAID = 1

Units= MB

Size = 152146MB
(33

Choose RAID Level For This VD

Status
ONLINE

Use Cursor Keys To Navigate Between Items And Press Enter To Select An Option

Select RAID from the Virtual Drive sub-menu, and then press <Enter>.
Select the RAID level from the menu, and then press <Enter>.

LSI Software RAID Configuration Utility Ver C.05 Sep 17, 2010

Virtual Drive(s) Configured-
#Stripes StripSz
148.580GB 2 64 KB
Initializ
Objects
Rebuild
Check Cor

Virtual Drive (- RAID Level:
RAT
MB

152146MB
Off
On

Choose RAID Level For T

Status
ONLINE

Use Cursor Keys To Navigate Between Items And Press Enter To Select An Option
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8.  Select Units from the Virtual Drive sub-menu, and then press <Enter>.
9.  Select the units for virtual drive size from the menu, and then press <Enter>.

LSI Software RAID Configuration Utility Ver C.05 Sep 17, 2010
Virtual Drive(s) Configured:
1D RAID Size #Stripes StripSz Status

Manager | ( 1 148.580GB 2 (L) ONLINE

Check Cor

Accept
SPAN = NO

Select Units For VD e

Use Cursor Keys To Navigate Between Items And Press Enter To Select An Option

10. When creating a RAID 1 or a RAID 10 set, select DWC from the Virtual
Drive menu, and then press <Enter>.

When creating a RAID 0 set, proceed to step 12.
11.  Select On to enable the Disk Write Cache setting, and then press <Enter>.

LSI Software RAID Configuration Utility Ver C.05 Sep 17, 2010
Virtual Drive(s) Configured-
1D RAID Size #Stripes StripSz Status

Manager | ( 1 148.580GB 2 64 KB ONLINE
Initializ
Objects

Rebuild Change DWC
Check Cor E}h
o q On
Virtual Drive 0 —

RAID = 1

MB
152146MB

RA =0n
Accept
SPAN = NO

Disk Write Cache Setting Of VD

Use Cursor Keys To Navigate Between Items And Press Enter To Select An Option

R Enabling DWC can improve the performance, but with the risk of data loss.
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12. When finished setting the selected virtual drive configuration, select Accept
from the menu, and then press <Enter>.

LSI Software RAID Configuration Utility Ver C.05 Sep 17, 2010
Virtual Drive(s) Configured-
)] RAID Size #Stripes StripSz Status

Manager | ( 1 148.580GB 2 64 KB ONLINE
Initializ
Objects
Rebuild
Check Cor
Virtual Drive 0
RAID = 1
Units= MB
Size = 152146MB
DWC = Off
RA =0n

Accept This VD Configuration And Go To Next VD

Cursor Keys, SPACE-(De)Select F2-ChIdInfo F3-SlotInfo F10-Configure Esc-Quit

13. Follow step 2 to 12 to configure additional virtual drives.

14.  Press <Esc> to finish RAID configuration. When prompted to save
configuration, select Yes from the menu, and then press <Enter>.

LSI Software RAID Configuration Utility Ver C.05 Sep 17, 2010
BIOS Version A.10.09231523R

Save Configuration?

gusation Ir—

w Configuration AAW No
iew/Add Configuration

Initializ Virtual Drive(s) Configured:

Objects i i
Rebuild #Stripes StripSz  Status

Check Con 148.580GB 2 64 KB ONLINE

Select Yes Or No

Use Cursor Keys to Navigate Between Items And Press Enter To Select An Option
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Using New Configuration

AEN

When a RAID set already exists, using the New Configuration command
erases the existing RAID configuration data. If you do not want to delete the
existing RAID set, use the View/Add Configuration command to view or create
another RAID configuration.

To create a RAID set using the New Configuration option

1. From the Management Menu, select Configure > New Configuration, and
then press <Enter>.

LSI Software RAID Configuration Utility Ver C.05 Sep 17, 2010
BIOS Version A.10.09231523R

Configuration Menu-
Easy Configuration

Management

View/Add Configuration

Initialize Clear Configuration
Objects Select Boot Drive
Rebuild

Check Consistency

Clear Existing Configuration And Start A New Configuration

Use Cursor Keys to Navigate Between Items And Press Enter To Select An Option

2. Follow step 2 to 9 of the previous section: Using Easy Configuration.
Select Size from the Virtual Drive menu, and then press <Enter>.
4.  Key-in the desired virtual drive size, and then press <Enter>.

LSI Software RAID Configuration Utility Ver C.05 Sep 17, 2010
Virtual Drive(s) Configured:
Size #Stripes StripSz Status

148.580GB 2 (L :) ONLINE

RAID = 1
Units= MB
DWC = Off
RA =0n
Accept
SPAN = NO

Enter VD Size:

Use Cursor Keys to Navigate Between Items And Press Enter To Select An Option

5. Follow step 10 to 14 of the previous section: Using Easy Configuration to
create the RAID set.
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5.2.2

Adding or viewing a RAID configuration

You can add a new RAID configuration or view an existing configuration using the
View/Add Configuration command.

Adding a new RAID configuration
To add a new RAID configuration:

1. From the Management Menu, select Configure > View/Add Configuration,
and then press <Enter>.

LSI Software RAID Configuration Utility Ver C.05 Sep 17, 2010
BIOS Version A.10.09231523R

Configuration Menu-

Initialize Clear Configuration
Objects Select Boot Drive
Rebuild

Check Consistency

View/Add to The Existing Configuration

Use Cursor Keys To Navigate Between Items And Press Enter To Select An Option

2. The ARRAY SELECTION MENU displays the available drives connected to
the SATA ports. Select the drive(s) you want to include in the RAID set, then
press <Space>. When selected, the drive indicator changes from READY to
ONLIN A[X]-[Y], where X is the array number, and Y is the drive number.

AN

LSI Software RAID Configuration Utility Ver C.05 Sep 17, 2010
BIOS Version A.10.09231523R
View/Add Configuration - ARRAY SELECTION MENU:
Management

Initialize ONLIN A00-00
Objects

Rebuild ONLIN A00-01
Check Consist READY

READY

Port # 2 DISK 77247MB  HDS72 LA380 PF20A60A

SPACE-Sel ,ENTER-EndArray,F10-Configure,F2-Drive Info,F3-Virtual Drives,F4-HSP

The information of the selected hard disk drive displays at the bottom of the
screen.

3. Follow step 3 to 12 of section 5.2.1 Creating a RAID set: Using Easy
Configuration to add a new RAID set.
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5.2.3 Initializing the virtual drives

After creating the RAID set(s), you must initialize the virtual drives. You may
initialize the virtual drives of a RAID set(s) using the Initialize or Objects command
on the Management Menu.

Using the Initialize command

To initialize the virtual drive using the Initialize command

1. From the Management Menu, select Initialize, and then press <Enter>.

LSI Software RAID Configuration Utility Ver C.05 Sep 17, 2010
BIOS Version A.10.09231523R

Management Menu.
Configure
Objects
Rebuild
Check Consistency

Initialize VD(s)

Use Cursor Keys To Navigate Between Items And Press Enter To Select An Option

2. The screen displays the available RAID set(s) and prompts you to select the
virtual drive to initialize. Use the arrow keys to select the virtual drive from the
Virtual Drive selection, and then press <Space>.

LSI Software RAID Configuration Utility Ver C.05 Sep 17, 2010
BIOS Version A.10.09231523R

Virtual Drive(s) Configured
Management Menu— | LD RAID Size #Stripes StripSz  Status
Configure

0 1 148.580GB 2 64 KB ONLINE
Objects

Rebuild

Check Consistency

>

Virtual Drives
0)

SPACE- (De) Select, Fl0-Initialize
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3.  Press <F10> to start initialization. When prompted, select Yes from the
Initialize? dialog box, and then press <Enter>.

LSI Software RAID Configuration Utility Ver C.05 Sep 17, 2010
BIOS Version A.10.09231523R

Virtual Drive(s) Configured
Management Menu— | LD RAID Size #Stripes StripSz  Status
Configure

0 1 148.580GB 2 64 KB ONLINE

Check Consistency
Virtual Drives
irtual Drive 0
Init Will Destroy Data On Selected VD(s)

SPACE- (De)Select, F10-Initialize

/ ' Initializing a virtual drive erases all data on the drive.

4. Aprogress bar appears on screen. If desired, press <Esc> to abort
initialization. When initialization is completed, press <Esc>.

LSI Software RAID Configuration Utility Ver C.05 Sep 17, 2010
BIOS Version A.10.09231523R

Virtual Drive(s) Configured-
Management Menu— | LD RAID i #Stripes StripSz  Status
1n__ acasnsum .
®  1nit"of VD1 'Tn Process &1 ¥R ONLINE

VD 0 Initialization Complete. Press Esc..

[0100% Completed
Virtue
Virtual Drive 0

SPACE- (De) Select, Fl10-Initialize
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Using the Objects command
To initialize the virtual drives using the Objects command

1. From the Management Menu, select Objects > Virtual Drive, and then
press <Enter>.

LSI Software RAID Configuration Utility Ver C.05 Sep 17, 2010
BIOS Version A.10.09231523R

= Objects:
Management:| Adapter
Configure
Initialize ysical Drive
o) =

Rebuild
Check Consistency

Change VD Parameters

Use Cursor Keys To Navigate Between Items And Press Enter To Select An Option

2. Select the virtual drive to initialize from the Virtual Drives sub-menu, and
then press <Enter>.

LSI Software RAID Configuration Utility Ver C.05 Sep 17, 2010
BIOS Version A 10.09231523R
1

Vitual Drive (1)

Ob:
Management |Adapter
Configure
Initialize Physical Drive
Objects ‘===

0
Rebuild
Check Consistency

Select VD

Press ENTER To Select A VD, <Del> To Delete A VD
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3. Select Initialize from the pop-up menu, and then press <Enter> to start
initialization.

LSI Software RAID Configuration Utility Ver C.05 Sep 17, 2010
BIOS Version A.10.09231523R
Vitual Drive (1)

d{Virtual Drive 0

Obj
Management |Adapter
Configure
Initialize Physical Drive
Objects ‘==

Rebuild ——Vitual Drive(0
Check Consistency

Check Consistency
View/Update Parameters

Initilize VD

Use Cursor Keys To Navigate Between Items And Press Enter To Select An Option

4. When prompted, press the <Space> to select Yes from the Initialize? dialog
box, and then press <Enter>.

LSI Software RAID Configuration Utility Ver C.05 Sep 17, 2010
BIOS Version A.10.09231523R

Vitual Drive (1)
5 irtual Drive 0

-0
Management | Adapter
Configure
Initialize |Pphysical Drive
Objects — === ;

O
Rebuild
Check Consistency

t Will Destroy Data On Selected VD(s

Use Cursor Keys To Navigate Between Items And Press Enter To Select An Option

5. Aprogress bar appears on screen. If desired, press <Esc> to abort
initialization. When initialization is completed, press <Esc>.
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5.24 Rebuilding failed drives

You can manually rebuild failed hard disk drives using the Rebuild command in the
Management Menu.

To rebuild a failed hard disk drive

1. From the Management Menu, select Rebuild, and then press <Enter>.

LSI Software RAID Configuration Utility Ver C.05 Sep 17, 2010
BIOS Version A.10.09231523R

Management Menu.
Configure
Initialize

Check Consistency

Rebuild PD(s)

Use Cursor Keys To Navigate Between Items And Press Enter To Select An Option

2. The PHYSICAL DRIVES SELECTION MENU displays the available drives
connected to the SATA ports. Select the drive you want to rebuild, and then
press <Space>.

LSI Software RAID Configuration Utility Ver C.05 Sep 17, 2010
BIOS Version A.10.09231523R

REBUILD - PHYSICAL DRIVES SELECTION MENU-
Management
Configure
Initialize ONLIN A00-00

ts
BAIL A00-01

Check Consist

Port # 1 DISK 77247MB  HDS728080PLA380  PF20A60A

SPACE- (De) Select,F10-Start Rebuild,F2-Drive Information,F3-View Virtual Drives

ASUS Z9NA-D6



After selecting the drive to rebuild, press <F10>. When prompted, press <Y>
to rebuild the drive.

LSI Software RAID Configuration Utility Ver C.05 Sep 17, 2010
BIOS Version A.10.09231523R

REBUILD - PHYSICAL DRIVES SELECTION MENU:

Management
Configure
itialize ONLIN A00-00

Port # 1 DISK 77247MB  HD LA3 PF20R60A

SPACE- (De) Select,F10-Start Rebuild,F2-Drive Information,F3-View Virtual Drives

When rebuild is complete, press any key to continue.
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5.2.5  Checking the drives for data consistency

You can check and verify the accuracy of data redundancy in the selected virtual
drive. The utility can automatically detect and/or detect and correct any differences
in data redundancy depending on the selected option in the Objects > Adapter
menu.

k The Check Consistency command is available only for virtual drives included
in a RAID 1 or RAID 10 set.

Using the Check Consistency Command

To check data consistency using the Check Consistency command

1. From the Management Menu, select Check Consistency, and then press
<Enter>.

LSI Software RAID Configuration Utility Ver C.05 Sep 17, 2010
BIOS Version A.10.09231523R

Management Menu
Configure
Initialize
Objects
Rebuild

Check Consistency

Use Cursor Keys To Navigate Between Items And Press Enter To Select An Option

2. The screen displays the available RAID set(s) and prompts you to select
the virtual drive to check. Press <Space> to select the virtual drive from the
Virtual Drive sub-menu, and then press <F10>.

LSI Software RAID Configuration Utility Ver C.05 Sep 17, 2010
BIOS Version A.10.09231523R

Virtual Drive(s) Configured
Management Menu— | LD RAID Size #Stripes StripSz  Status
Configure
Initialize 0 1 148.580GB 2 64 KB ONLINE
Objects
Rebuild

Check Consistency

Virtual Drives
irtual Drive 0|

SPACE- (De) Select, F10-Check Consistency
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3.

When prompted, use the arrow keys to select Yes from the Consistency
Check? dialog box, and then press <Enter>.

LSI Software RAID Configuration Utility Ver C.05 Sep 17, 2010
BIOS Version A.10.09231523R

Virtual Drive(s) Configured
Management Menu— | LD RAID Size #Stripes StripSz  Status
Configure 0 10 154494MB 4 64 KB ONLINE
Initialize
Objects
Rebuild

Check Consistency

Virtual Drives
irtual Drive 0]

SPACE- (De) Select, F10-Check Consistency

A progress bar appears on screen.

LSI Software RAID Configuration Utility Ver C.05 Sep 17, 2010
BIOS Version A.10.09231523R

Virtual Drive(s) Configured
Management Menu— | LD RAID Size #Stripes StripSz  Status
. n n 1CAANAAm (3

'Cc under Process— 2 ONLINE
Objects VD 0 Consistency Check. Press Esc to Abort.

Rebuild

Check Cc| |

085 % Completed
Virtu«

The Data On The Drives Is Inconsistency. Repair Done!

SPACE- (De) Select, F10-Check Consistency

While checking the disk consistency, press <Esc> to display the following
options.

+ Stop - Stops the consistency check. The utility stores the
percentage of disk checked, and when you restart checking,
it continues from the last percentage completed rather than
from zero percent.

+ Continue - Continues the consistency check.

« Abort - Aborts the consistency check. When you restart checking, it
continues from zero percent.

When checking is complete, press any key to continue.
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Using the Objects command
To check data consistency using the Objects command

1.

From the Management Menu, select Objects, and then select Virtual Drive
from the sub-menu.

Use the arrow keys to select the virtual drive you want to check, and then
press <Enter>.

Select Check Consistency from the pop-up menu, and then press <Enter>.

When prompted, use the arrow keys to select Yes from the dialog box to
check the drive.

When checking is complete, press any key to continue.
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5.2.6 Deleting a RAID configuration

To delete a RAID configuration

1. From the Management Menu, select Configure > Clear Configuration, and
then press <Enter>.

LSI Software RAID Configuration Utility Ver C.05 Sep 17, 2010
BIOS Version A.10.09231523R
Configuration Menu-
Easy Configuration
Management |New Configuration

View/Add Configuration
Initialize
Objects Select Boot Drive
Rebuild
Check Consistency

Clear Existing Configuration

Use Cursor Keys To Navigate Between Items And Press Enter To Select An Option

2. When prompted, use the arrow keys to select Yes from the Clear
Configuration? dialog box, and then press <Enter>.

LSI Software RAID Configuration Utility Ver C.05 Sep 17, 2010
BIOS Version A.10.09231523R

Configuration Menu-
Easy Configuration

q Clear Configuration?.
Initialize
Objects Select| No
Rebuild

Check Consistency

ear Existing Configuration

Use Cursor Keys To Navigate Between Items And Press Enter To Select An Option

The utility clears all the current array(s).
3. Press any key to continue.
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5.2.7  Selecting the boot drive from a RAID set

You must have created a new RAID configuration before you can select the
boot drive from a RAID set. See section 5.2.1 Creating a RAID set: Using New
Configuration for details.

To select the boot drive from a RAID set

1.

2.

3.

From the Management Menu, select Configure > Select Boot Drive, and
then press <Enter>.

LSI Software RAID Configuration Utility Ver C.05 Sep 17, 2010
BIOS Version A.10.09231523R

Configuration Menu.
Easy Configuration

View/Add Configuration

Initialize Clear Configuration
Chjects
Rebuild

Check Consistency

Select A Boot VD

Use Cursor Keys To Navigate Between Items And Press Enter To Select An Option

When prompted, use the arrow keys to select the bootable virtual drive from
the list, then press <Enter>.

LSI Software RAID Configuration Utility Ver C.05 Sep 17, 2010
BIOS Version A.10.09231523R

. Bootable VDs (1) :Current Boot VD(0)
2l Boot Drive 0
Easy Con

Management |New Configuration
View/Add Configuration
Initialize Clear Configuration
Chjects
Rebuild
Check Consistency

Select A Boot VD

Use Cursor Keys To Navigate Between Items And Press Enter To Select An Option

The virtual drive is selected as boot drive. Press any key to continue.

ASUS Z9NA-D6 5-23



5-24

5.2.8 Enabling WriteCache

You may manually enable the RAID controller’s WriteCache option after creating a
RAID set to improve the data transmission performance.

//' When you enable WriteCache, you may lose data when a power interruption occurs
H while transmitting or exchanging data among the drives.

% The WriteCache function is recommended for RAID 1 and RAID 10 sets.

To enable WriteCache

1. From the Management Menu, select Objects > Adapter, select an existing
adapter, and then press <Enter> to display the adapter properties.

2. Select Disk WC, and then press <Enter> to turn on the option.

LSI Software RAID Configuration Utility Ver C.05 Sep 17, 2010
BIOS Version A.10.09231523R

Adapt
Rebuild Rate = 30
Chk Const Rate = 30
FGI Rate
1V| BGI Rate

i 3
v 3
o

El

S o o

Read Ahead
Bios State nable
Cont On Error = Yes
Fast Init = Enable
Auto Rebuild

Auto Resume

Disk Coercion = 1GB
Factory Default

Check Consistency

Disk Write Cache - Off (Write Through) or On(Write Back)

Use Cursor Keys To Navigate Between Items And Press Enter To Select An Option

3.  From the Management Menu, select Objects > Virtual Drive, select an
existing adapter and press <Enter>. Select View/Update Parameters and
press <Enter> to display the adapter properties.

Select Disk WC, and then press <Enter> to turn on the option.

LSI Software RAID Configuration Utility Ver C.05 Sep 17, 2010
BIOS Version A.10.09231523R
Virtual Dgive

Management | Adapt: Ok size 148.580GB
aptel Stripe Size 4]

e irtual D #Strgpes

Initialize Physical

Objects R

State

Rebuild cpans

Check Consistency Read Ahead

Write Cache Setting of VD

Use Cursor Keys To Navigate Between Items And Press Enter To Select An Option

5. When finished, press any key to continue.
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5.3 Intel® Rapid Storage Technology
enterprise SCU/SATA Option ROM
Utility

The Intel® Rapid Storage Technology enterprise SCU / SATA Option ROM utility

allows you to create RAID 0, RAID 1, RAID 10 (RAID 1+0), and RAID 5 set(s)

from Serial ATA hard disk drives that are connected to the Serial ATA connectors
supported by the Southbridge.

To use onboard SATA ports:

1. Install all the Serial ATA hard disk drives.

2. Turning on the system. During POST, press,Del. to enter BIOS. Go to
Advanced Menu > PCH SATA Configuration > SATA Mode, then press
<Enter>.

3. Set SATA Mode to RAID Mode and save, then reboot system.
4. During POST, press <Ctrl+I> to display the utility main menu.

To use SCU SATA ports:

1. Install all the SATA hard disk drives.

2. Confirm all the SATA hard disk drives you installed are correctly displayed,
then reboot system.

3. During POST, press <Ctrl+I> to display the utility main menu.
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To enter the Intel® Rapid Storage Technology enterprise SCU Option ROM utility:

1.
2.
3.

Install all the Serial ATA hard disk drives.
Turn on the system.
During POST, press <Ctrl+I> to display the utility main menu.

Intel (R) Rapid Storage Technology enterprise - SATA Option ROM - 3.0.0.1104
Copyright(C) 2003-11 Intel Corporation. All Rights Reserved.

[ 1

1. Create RAID Volume 3. Reset Disks to Non-RAID
2. Delete RAID Volume 4. Exit

RAID Volumes:
None defined.

Physical Disks:

ID Drive Model Serial # Size Type/Status(Vol ID)
0 ST3300656SS HWAS0000991753TR 279.3GB

1 ST3300656SS 37VN00009846RAJL 279.3GB

2 ST3300656SS 39760000984 6UEDY 279.3GB

3 ST3300656SS GWC50000991756G6 279.3GB

[1}]1-Select [ESC]-Exit [ENTER] -Select Menu

The navigation keys at the bottom of the screen allow you to move through
the menus and select the menu options.

R The RAID BIOS setup screens shown in this section are for reference only and

may not exactly match the items on your screen.

/ The utility supports maximum four hard disk drives for RAID configuration.
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5.3.1 Creating a RAID set
To create a RAID set

1. From the utility main menu, select 1. Create RAID Volume and press
<Enter>. The following screen appears.

Intel (R) Rapid Storage Technology enterprise - SATA Option ROM - 3.0.0.1104
Copyright(C) 2003-11 Intel Corporation. All Rights Reserved.

[ 1
Name:
RAID Level: RAIDO(Stripe)
Disks: Select Disks
Strip Size: 128KB
Capacity: 0.0 GB

Create Volume

Enter a unique volume name that has no special characters and is
16 characters or less.

[1]]1Change [TAB] -Next [ESC] -Previous Menu [ENTER] -Select

2. Enter a name for the RAID set and press <Enter>.

3. When the RAID Level item is selected, press the up/down arrow key to select
a RAID level to create, and then press <Enter>.

4. When the Disks item is selected, press <Enter> to select the hard disk drives
you want to include in the RAID set. The SELECT DISKS screen appears.

Port Drive Model Serial # Size Status

i ST3300656SS 37VN0O0009846RAJ1 279.3GB  Non-RAID Disk
2 ST3300656SS 397600009846UEDY 279.3GB  Non-RAID Disk
3] ST3300656SS GWC50000991756G6 279.3GB  Non-RAID Disk

Select 2 to 6 disks to use in creating the volume.

11 -Prev/Next [SPACE]-SelectDisk [ENTER]-Done

5. Use the up/down arrow key to select a drive, and then press <Space>
to select. A small triangle marks the selected drive. Press <Enter> after
completing your selection.
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6.  Use the up/down arrow keys to select the stripe size for the RAID array (for
RAID 0, 10 and 5 only), and then press <Enter>. The available stripe size
values range from 4 KB to 128 KB. The following are typical values:

RAID 0: 128KB
RAID 10: 64KB
RAID 5: 64KB

R We recommend a lower stripe size for server systems, and a higher stripe size
for multimedia computer systems used mainly for audio and video editing.

7. When the Capacity item is selected, enter the RAID volume capacity that you
want and press <Enter>. The default value indicates the maximum allowed
capacity.

8. When the Create Volume item is selected, press <Enter>. The following
warning message appears.

Are you sure you want to create this volume? (Y/N):

9. Press <Y> to create the RAID volume and return to the main menu, or <N> to
go back to the CREATE VOLUME menu.

5.3.2 Creating a Recovery set
To create a recovery set:

1. From the utility main menu, select 1. Create RAID Volume and press
<Enter>. The following screen appears.

Intel (R) Rapid Storage Technology enterprise - SATA Option ROM - 3.0.0.1104
Copyright (C) 2003-11 Intel Corporation. All Rights Reserved.

[ 1

Name:
RAID Level: RAIDO (Stripe)
Disks: Select Disks
Strip Size: 128KB
Capacity: 0.0 [¢):}
Sync: N/A
Create Volume

Enter a unique volume name that has no special characters and is
16 characters or less.

[1|]Change [TAB] -Next [ESC] -Previous Menu [ENTER] -Select
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2. Enter a name for the recovery set and press <Enter>.

3. When the RAID Level item is selected, press the up/down arrow keys to
select Recovery, and then press <Enter>.

4. When the Disks item is selected, press <Enter> to select the hard disk drives
you want to include in the recovery set. The SELECT DISKS screen appears.

Port Drive Model Serial # Size Status

1 ST3300656SS 37VNO0009846RAJ1 279.3GB  Non-RAID Disk

2 ST3300656SS 397600009846UEDY 279.3GB  Non-RAID Disk
3

ST3300656SS GWC50000991756G6 279.3GB  Non-RAID Disk

Select 1 Master and 1 Recovery disk to create volume.

[[1|]-Prev/Next [TAB]-(M)aster [SPACE]-(R)ecovery [ENTER]-Done

5. Use the up/down arrow keys to select a drive, press <TAB> to select a Master
disk, and then press <SPACE> to select a Recovery disk. A small triangle
marks the selected drive. Press <Enter> after completing your selection.

6. When the Sync item is selected, use the up/down arrow keys to select a sync
option that you want and press <Enter>.

7. When the Create Volume item is selected, press <Enter>. The following
warning message appears.

Are you sure you want to create this volume? (Y/N):

8.  Press <Y>to create the recovery set and return to the main menu, or <N> to
go back to the CREATE VOLUME menu.

R If a recovery set is created, you cannot add more RAID sets even when you
have more non-RAID disks installed in your system.
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5.3.3 Deleting a RAID set

Take caution when deleting a RAID set. You will lose all data on the hard disk
H drives when you delete a RAID set.

To delete a RAID set:

1. From the utility main menu, select 2. Delete RAID Volume and press
<Enter>. The following screen appears.

Intel (R) Rapid Storage Technology enterprise - SATA Option ROM - 3.0.0.1104
Copyright (C) 2003-11 Intel Corporation. All Rights Reserved.

[ 1

Name Level Drives Capacity Status Bootable
olume( RAIDO (Stripe) 2 298.0GB Normal Yes

[ 1

Deleting a volume will reset the disks to non-RAID.

ALL DISK DATA WILL BE DELETED.
(This does not apply to Recovery volumes)

[1}]1-Select [ESC] -Previous Menu [DEL] -Delete Volume

2. Use the up/down arrow keys to select the RAID set you want to delete, and
then press <Del>. The following warning message appears.

(This does not apply to Recovery volumes)

Are you sure you want to delete volume “Volume0”? (Y/N):

3. Press <Y>to delete the RAID set and return to the utility main menu, or press
<N> to return to the DELETE VOLUME menu.
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5.3.4 Resetting disks to Non-RAID

/'\\ Take caution before you reset a RAID volume hard disk drive to non-RAID.
R \ Resetting a RAID volume hard disk drive deletes all internal RAID structure on
the drive.

To reset a RAID set hard disk drive:

1. From the utility main menu, select 3. Reset Disks to Non-RAID and press
<Enter>. The following screen appears.

[ 1

Resetting RAID disk will remove its RAID structures
and revert it to a non-RAID disk.

(This does not apply to Recovery volumes)
Port Drive Model Serial # Size  Status

0 ST3300656SS HWAS0000991753TR 279.3GB _ Member Disk
1 ST3300656SS 37VNO0009846RAJ1 279.3GB

Select the disks that should be reset.

[1]|]1-Previous/Next [SPACE]-Selects [ENTER]-Selection Complet:

2. Use the up/down arrow keys to select the RAID set drive(s) you want to reset,
and then press <Space> to select.

3. Press <Enter> to reset the RAID set drive(s). A confirmation message
appears.

4.  Press <Y> to reset the drive(s) or press <N> to return to the utility main
menu.
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5.3.5 Exiting the Intel® Rapid Storage Technology utility
To exit the utility:

1. From the utility main menu, select 4. Exit, and then press <Enter>. The
following warning message appears.

|: [ 1 :|
Are you sure you want to exit? (Y/N):

2. Press <Y>to exit or press <N> to return to the utility main menu.

5.3.6 Rebuilding the RAID

R This option is only for the RAID 1 set.

Rebuilding the RAID with other non-RAID disk

If any of the SATA hard disk drives included in the RAID 1 array failed, the system
displays the status of the RAID volume as “Degraded” during POST. You can
rebuild the RAID array with other installed non-RAID disks.

To rebuild the RAID with other non-RAID disk:

1. Atthe prompt, press <Ctrl> + <I> to enter the Intel Rapid Storage Technology
option ROM utility.

2. Ifthere is a non-RAID SATA Hard Disk available, the utility will prompt to
rebuild the RAID. Press <Enter>, and then use up/down arrow keys to select
the destination disk or press <ESC> to exit.

[ 1

"Degraded" volume and disk available for rebuilding detected. Selecting
a disk initiates a rebuild. Rebuild completes in the operating system.

Select the port of destination disk for rebuilding (ESC to exit):
Port Drive Model Serial # Size
X XXXXXXXXXXX XXXXXXXX XX.XGB

[1|]1-Previous/Next [ENTER]-Select [ESC]-Exit

R Select a destination disk with the same size as the original hard disk.
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3. The utility immediately starts rebuilding after the disk is selected. The status
of the degraded RAID volume is changed to “Rebuild”.

Intel(R) Rapid Storage Technology enterprise - SATA Option ROM - 3.0.0.1104
Copyright (C) 2003-11 Intel Corporation. All Rights Reserved.

[ 1
1. Create RAID Volume 3. set Disks to Non-RAID
4. i

2. Delete RAID Volume slig

[ 1

RAID Volumes: = Data is Encrypted
ID Name Level Strip Size Status Bootable
(0] VolumeO RAID1 (Mirror) N/A 149.0GB Rebuild Yes

Physical Devices:

Port Drive Model Serial # Size Type/Status (Vol ID)
1 ST3160812AS 9LSOF4HL 149.0GB

2 ST3160812AS 3LS0JYL8 149.0GB

Volumes with “Rebuild” status will be rebuilt within the operating system.

[1l]1-Select [ESC] -Exit [ENTER] -Select Menu

Exit Intel Rapid Storage Technology and reboot the system.

5. Under Microsoft® Windows OS, select Start > Programs > Intel Rapid
Storage > Intel Rapid Storage Console or click the Intel Rapid Storage
Technology tray icon to load the Intel Rapid Storage Manager utility.

6. From the View menu, select Advanced Mode to display the details of the
Intel Rapid Storage Console.

7. From the Volumes view option, select RAID volume to view the rebuilding
status. When finished, the status is changed to “Normal’.

Rebuilding the RAID with a new hard disk

If any of the SATA hard disk drives included in the RAID array failed, the system
displays the status of the RAID volume as “Degraded” during POST. You may
replace the disk drive and rebuild the RAID array.

To rebuild the RAID with a new hard disk:

1. Remove the failed SATA hard disk and install a new SATA hard disk of the
same specification into the same SATA Port.

R Select a destination disk with the same size as the original hard disk.

2. Reboot the system and then follow the steps in section Rebuilding the RAID
with other non-RAID disk.
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5.3.7 Setting the Boot array in the BIOS Setup Utility

You can set the boot priority sequence in the BIOS for your RAID arrays when
creating multi-RAID using the Intel® Rapid Storage Technology.

To set the boot array in the BIOS:

R Set at least one of the arrays bootable to boot from the hard disk.

1. Reboot the system and press <Del> to enter the BIOS setup utility during
POST.

2. Go to the Boot menu and select the boot option priority.

Use up/down arrow keys to select the boot priority and press <Enter>. See
section 4.7 Boot menu for details.

From the Exit menu, select Save Changes & Exit, then press <Enter>.
5. When the confirmation window appears, select Yes, then press <Enter>.
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5.4 Intel® Rapid Storage Technology
enterprise Utility (Windows)

The Intel® Rapid Storage Technology enterprise utility allows you to create RAID 0,
RAID 1, RAID 10 (RAID 1+0), and RAID 5 set(s) from Serial ATA hard disk drives
that are connected to the Serial ATA connectors supported by the Southbridge.

Before you using Intel® Rapid Storage Technology enterprise utility, you need to
change BIOS setting first:
1. Enter the BIOS Setup during POST.

2. Go to the Advanced Menu > Chipset Configuration > PCH Configuration
> Onboard SAS Oprom, then press <Enter>.

3.  Set Onboard SAS Oprom to [Enabled)].
4. Press <F10> to save your changes and exit the BIOS Setup.

k You need to manually install the Intel® Rapid Storage Technology enterprise
utility on a Windows® operating system. Please refer to the installation
instructions in Chapter 6.

To enter the Intel® Rapid Storage Technology enterprise utility under Windows
operating system:
1. Turn on the system to windows desktop.

2. Click the Intel® Rapid Storage Technology enterprise icon to display the
main menu.

Your storage system is configured for data protection, increased performance and
optimal data storage capacity. You can further optimize your storage system by
creating additional volumes.

algix

[Ees @

‘:' -n “ o

/ You can click Rescan to re-scan any attached hard disks.
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5.4.1

Creating a RAID set

To create a RAID set

1.
2.

3.
4.
5.

From the utility main menu, select Create Volume and select volume type.
Then click Next.

|
Select Controller
2. Configure ® Intel(R) C600 series chipset SAS RAID Controller
Select Volume Type _ —
® Real-time data protection (RAID 1) Protection ()
O Optimized disk perfarmance (RAID 0) Performance (L)
O Efficient data hosting and protection (RAID 5) capacity @] )

O Balanced performance and data protection (RAID (L e 3 volume where
each disk stores an exact copy of the data and

provides real-time redundancy.

m Cancel More help on this page

Enter a name for the RAID set, then select the array disks.
Select Volume Size tab, you can drag the bar to decide the volume size.
Then click Next.

]
1. Select Configure Volume Proposed Configuration
2. Configure Name: [Volume 0000 New Aray
3. Confirm - % Volume_0000
Select the array disks (minimum selection required:
¥ sAs disk on Cantroller 1, Phy 0 (279 GB) ==

¥ s disk on Controller 1, Phy 2 (279 GB)

Volume Size | Advanced |

Volume Size 4,468 ME:

Array allocation: J ., %D

Back m Cancel More help on this page

R + If you hard disk with existing data and you don’t want to keep data from one

of the selected disks, choose NO in next column (If displayed).

+  If you want to Enable volume write-back cache or Initialize volume, you
can click Advanced tab to slelect.
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6.  Confirm volume creation, than click Create Volume to continue.

This process could take a while depending on the number and size of the disks.
You can continue using other applications during this time.

x|
1. Select Confirm Volume Creation Proposed Configuration
Review the selected configuration.
2. Configure New Array
O This process could take 3 while depending on the number and size of the % Volume 0000
disks. You can continue using other applications during this time. -
==
oo | TR | oo ere e on i age
When display Volume Ceation Complete message, you can click OK to finish.

e

The volume was created successfully.

@ You still need ta partition your new volume using Windows Disk Management* before adding
any data.

More help ﬂ

You still need to partition your new volume using Windows Disk Management
before adding any data.

When you are finished, you will see the following screen in Volumes field and you
can change related items in the Volume Properties field.

[ e ~
[2 . @

ey ——

Gevass Vetamen
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5.4.2 Change Volume Type

When you are finished to create a RAID set, you can view or change related items
in the Volume Properties field.

According to the following steps to change the type in Volume Properties:

1. Click the SATA array items you want to change in Volumes field.
2  From the Volume Properties field, select Type:RAID 1 Change type.

logy enterprise |
) (inteD

system is functioning normally.

Volume. Volume Properties

Name: Volume_0000 Rename

Volumes. Status: Normal
[ Type: RAID 1 Change type I
chipset SAS RAID Controller  SAS_ATTay_0000 i - "
; 1 system volume: No Delete volume
%V" [FIELEED Write-back cache: Disabled Enable 7

Initialized: No Initialize 7

Verification details Verify
parity errors: 0
Blocks with media errors: 0
Physical sector size: 512 Bytes
Logical sector size: 512 Bytes

3. You can change the Name, Select the new volume type, and Select

additional disks to include in the new volume if needed.

4.  Then select the Data stripe size for the RAID array (for RAID 0, 10 and 5

only), and then click OK. The available stripe size values range from 4 KB to
128 KB. The following are typical values:

RAID 0: 128KB

RAID 10: 64KB

RAID 5: 64KB

(Change Volume Type )

Name: |vdume,nnnn

I Select the new volume type: I

@® Optimized disk performance (RAID 0)
O Efficient data hosting and protection (RAID 5)

@ The new volume will automatically include the disks that are part of the existing volume.

| Select additional disks to include in the new volume: 7

sas disk on Controller 1, Phy 4
SAS disk on Controller 1, Phy 6

| Data stripe size: n ] |

L WARNING: Completing this action will i start the volume process. Any data
on the disks to be added to the volume will be permanently lost and should be backed up
before continuing. Volume data will be preserved. Performing a driver upgrade or downgrade
while a volume migration is in progress may make the volume inaccessible due to driver
incompatibility.

More help oK

R We recommend a lower stripe size for server systems, and a higher stripe size

for multimedia computer systems used mainly for audio and video editing.
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5.4.3 Delete volume

-

'\\ Take caution when deleting a volume. You will lose all data on the hard disk
(/ HA drives.Back up data before continuing.

To delete a volume:

1. From the utility main menu, select the volume (exp. Volume_0000) in
Volumes field you want to delete.

logy enterprise IS

9 =)

system is functioning normally.

Volume. Volume Properties
Name: Volume_0000 Rename

Volumes Status: Normal

Type: RAID 1 Change type
chipset SAS RAID Controller | _SAS_Arfay_0000 Sizei 468 ME Incresse size
System volume: No Delete volume

Initialized: No Initialize &

Verification details Verify
Parity errors: 0
Blocks with media errors: 0
Physical sector size: 512 Bytes
Logical sector size: 512 Bytes

2. Then select Delete volume in Volume Properties field. The following screen
appears.

Delete Volume [
Are you sure you want to delete this volume?

L WARNING: Completing this action will permanently delete existing data on the selected volume.
Back up data before continuing.

More help Yes I m

3.  Click Yes to delete the volume and return to the utility main menu, or click No
to return to the main menu.
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544 Preferences

System Preferences

Allow you set to show the notification area icon and show system information, warning, or
errors here.

Sy Pofrces
E-mail ¥ Show the notification ares icon

Show the followirsg notifications:
W Steesga system information
W Stocage gystem wantings
¥ Storage system errors

E-Mail Preferences
Allow you set to sent e-mail of the following events:
Storage system information

Storage system warnings
Storage system errors

System E-mail Praferances

Fmal Moty me by emad of the followng events:
Storage system informaticn
Storage system wamings
Storage system enors.

iy Gl 4 ity Mot help on th page
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This chapter provides the instructions
for installing the necessary drivers for
different system components.

Driver
installation



6.1
6.2
6.3
6.4
6.5
6.6
6.7
6.8

RAID driver installation ... 6-3
Intel® chipset device software installation............co.cecueernenne. 6-16
Intel® Network Connections Software installation................. 6-19
VGA driver installation..........cccueeevemrenmsnmnssmsssssssssssssssssssesseeas 6-22
Intel® C600 Series Chipset SCU SATA RAID Drivers............... 6-25
Intel® Rapid Storage Technology enterprise 3.0 installation . 6-26
Intel® WG82574L Gigabit Adapters Driver installation............ 6-29
Management applications and utilities installation................. 6-33
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6.1 RAID driver installation

After creating the RAID sets for your server system, you are now ready to install
an operating system to the independent hard disk drive or bootable array. This part
provides the instructions on how to install the RAID controller drivers during OS
installation.

6.1.1 Creating a RAID driver disk

k The system does not include a floppy drive. You have to use a USB floppy drive
when creating a SATA RAID driver disk.

the boot priority of the SATA optical disk drive has to be manually adjusted.

% If you have created RAID sets with the LSI Software RAID configuration utility,
Otherwise, the system will not boot from the connected SATA ODD.

Afloppy disk with the RAID driver is required when installing Windows® XP / Server
2003 or Linux operating system on a hard disk drive that is included in a RAID set.
You can create a RAID driver disk in DOS (using the Makedisk application in the
support DVD).

To create a RAID driver disk in DOS environment

Place the motherboard support DVD in the optical drive.
2. Restart the computer, and then enter the BIOS Setup.

Select the optical drive as the first boot priority to boot from the support DVD.
Save your changes, and then exit the BIOS Setup.

4.  Restart the computer. The Makedisk menu appears.

Create Driver Diskette Menu
C600 INTEL RAID Driver

C600 LSI RAID Driver
MARVELL 9230 SATA Driver

Write DMI
FreeDOS command prompt

5. Use the arrow keys to select the type of RAID driver disk you want to create
and press <Enter> to enter the sub-menu.

C600 INTEL RAID Driver

C600 INTEL RAID Driver
Windows 32 bit (AHCI / AHCI RAID)
Windows 64 bit (AHCI / AHCI RAID)
Windows 32 bit (SCU RAID)

Windows 64 bit (SCU RAID)
Back
Exit
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LSI 2008 SAS2 Driver

LSI 2008 SAS2 Driver

Windows
Windows
Windows
Windows
Windows
Windows
Windows
Windows
Windows
Windows
Windows

XP 32 bit

XP 64 bit

Server 2003 32 bit
Server 2003 64 bit
Vista 32 bit
Vista 64 bit
Server 2008 32 bit
Server 2008 64 bit
7 32 bit

7 64 bit

Server 2008 R2 64 bit

RHEL 4 UP7 32 bit
RHEL 4 UP7 64 bit
RHEL 4 UP8 32 bit
RHEL 4 UP8 64 bit

Back
Exit

Locate the RAID driver and place a blank, high-density floppy disk to the
floppy disk drive.

Press <Enter>.

Follow screen instructions to create the driver disk.
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To create a RAID driver disk in Windows® environment
1. Start Windows®.
2. Place the motherboard support DVD into the optical drive.

3. Go to the Make disk menu, and then select the type of RAID driver disk you
want to create.

Insert a floppy disk into the USB floppy disk drive.
5. Follow succeeding screen instructions to complete the process.

/ Write-protect the floppy disk to avoid computer virus infection.

To create a RAID driver disk in Red Hat® Enterprise Linux server environment

1. Insert a blank formatted high-density floppy disk to the USB floppy disk drive.
2. Typedd if=XXX.img of=/dev/£d0 to decompress the file into the floppy
disk from the following path in the support DVD:

For LSI MegaRAID Driver
\Drivers\C600 LSI RAID\Driver\makedisk\Linux
3. Eject the floppy disk.
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3.  Click Load Driver.

6.1.2 Installing the RAID controller driver

During Windows® Server 2008 OS installation

To install the RAID controller driver when installing Windows® Server 2008 OS

1. Boot the computer using the Windows® Server 2008 OS installation disc.
Follow the screen instructions to start installing Windows Server 2008.

2. When prompted to choose a type of installation, click Custom (advanced).

@ £ Tnstall Windovis -

Which type of installation da you want?

Upgra:
o

Help me decide

& £7 sl vindous =

Where do you want to install Windows?

[ Name I Total Size. Fres Space | Type

57 DiskoParttion1 1524 6B 144168 System

55 DiskLUnalloceted Spece 148168 148168

43 Refresh Drive options (sdvanced)
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8.

A message appears, reminding you to insert the installation media containing
the driver of the RAID controller driver. If you have only one optical drive
installed in your system, eject the Windows OS installation disc and replace
with the motherboard Support DVD into the optical drive. Click Browse to
continue.

Load Driver &

To install the device driver needed to access your hard drive, insert the installation
media containing the driver files, and then click OK.

Note: The installation media can be a floppy disk, CD, DVD, or USB flash drive.

CCaore 1D o0 ] [ Gancel |

Locate the driver in the corresponding folder of the Support DVD, and then
click OK to continue.

Select the RAID controller driver you need from the list and click Next.

When the system finishes loading the RAID driver, replace the motherboard
Support DVD with the Windows Server installation disc. Select the drive to
install Windows and click Next.

@ £ Install Windows ES
Where do you want to install Windows?
[ Name [ Total Size Free Space] Type I
45 Disk0 Parttion 152468 14406GB System
‘ L7 Disk1 Partition1 502368 5849GB Primary ‘
9 Refrech Drive options (advanced
Load Driv
=)
v/

Setup then proceeds with the OS installation. Follow screen instructions to
continue.
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Red Hat® Enterprise Linux OS 5.6

To install the LSI MegaRAID controller driver when installing Red Hat® Enterprise
Os:

1. Boot the system from the Red Hat® OS installation CD.

2. Atthe boot:, type linux dd noprobe=atal noprobe=ata2..., then
press <Enter>.

k The number of ata varies with the hard disk drive number you have when
building a RAID set. For example, if you want to build a RAID set with 6 hard
disk drives, type command line: linux dd noprobe=ata1 noprobe=ata2
noprobe=ata3 noprobe=ata4 noprobe=ata5 noprobe=ata6.

- To install or upgrade in graphical mode, press the <ENTER> key.
- To install or upgrade in text mode, type: linux text <ENTER>.
- Use the function keys listed below for more information.

boot: linux dd noprobe=atal noprobe=ata2

3. Select Yes using the <Tab> key when asked if you have the driver disk, then
press <Enter>.

4| Main Menu |7

Do you have a driver disk?

4. Insert the Red Hat® Enterprise RAID driver disk to the USB floppy disk drive,
select OK, then press <Enter>.

4| Insert Driver Disk |7

Insert your driver disk into /dev/£d0
and press “OK” to continue.

The drivers for the RAID card are installed to the system.
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5. When asked if you will load additional RAID controller drivers, select No, then
press <Enter>.

—| More Driver Disks? l—

Do you wish to load any more
driver disks?

6. Follow the onscreen instructions to finish the OS installation.

7. When the installation is completed, DO NOT click Reboot. Press <Ctrl>
+ <Alt> + <F2> to switch to the command-line interface from graphic user
interface.

8.  Type the following commands when using a Legacy floppy.

mkdir /mnt/driver

mount /dev/£d0 /mnt/driver
cd /mnt/driver

sh replace_ahci.sh

reboot
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Red Hat® Enterprise Linux OS 6.1
To install the LSI MegaRAID controller driver when installing Red Hat® Enterprise
Os:
Boot the system from the Red Hat® OS installation CD.
2. Press <Tab> to edit options.

Helcone to Red Hat Enterprise Linux 6.1t

ﬂnstall or upgrade an existing system
Install system with basic video driver
Rescue installed system

Boot from local drive

Menory test

Press [Tabl to edit options

3. Entering the following command at the boot: 1inux dd blacklist=isci
blacklist=ahci nodmraid, then press <Enter>.

Helcone to Red Hat Enterprise Linux 6.1t

Install or upgrade an existing system
Install system with basic video driver
Rescue installed system

Boot from local drive

Menory test

> unlinuz initrd=linux dd blacklist=isci blacklist=ahci nodmraid_

RED HAT’
ENTERPRISE LINUX’ 6 \ 3

Copyright © 2003-2010 Red Hat, Inc. and others. All ights reserved.
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4.  Select Yes using the <Tab> key when asked if you have the driver disk, then
press <Enter>.

i Main Menu |7

Do you have a driver disk?

5. You have multiple devices which could serve as source for a driver disk. Choose
one you like to use and select OK, then press <Enter>.

—lDriver Disk SouSrce|7

You have multiple devices which could
serve as source for a driver disk.
Which would you like to use?

sdc

sdd

sr0
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7.

8.

Insert the Red Hat® Enterprise RAID driver disk to the USB floppy disk drive,
select OK, then press <Enter>.

4| Insert Driver Disk |7

Insert your driver disk into /dev/sdb
and press “OK” to continue.

The drivers for the RAID card are installed to the system.

When asked if you will load additional RAID controller drivers, select No, then
press <Enter>.

| More Driver Disks? l—

Do you wish to load any more
driver disks?

Follow the onscreen instructions to finish the OS installation.
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Preparing the Linux Driver

Ensure that there is another computer with a Linux-based OS to create the RAID
driver. When creating the RAID driver, you may refer to the examples below which
uses a 64bit SUSE Linux system to create a 64bit RAID driver for SUSE11 sp1.

1. Copy the image file into the Linux system.
Example: megasr-15.00.0120.2012-1-slesll-ga-x86_64.img
2.  Create a folder.
Example: image
3. Mount the image file into the image folder using this command format:
mount -o loop [image file name] image

Example: mount -o loop megasr-15-15.00.0120.2012-1-slesll-
ga-x86__64.img image

asus@|inux:does:imp.

File Edit WView Terminal Tabs Help

asus@linux-doeS: /tmp= su - (-]
Password:

linux-doeS:~ # ..

linux-doeS:/ # cd tmp

Linux-doeS: /tmp # mount -o loop megasr-15.00.0120.2012-1-slesll-ga-x86_64.img image

linux-doeS: /tmp #

4. Copy the contents of the image directory, labeled as 01, into a FAT32 USB
drive.

- image - File Browser = @ 3
File Edit View Go Bookmarks Tabs Help
€ . & = &= = @

Back up Reload Home  Computer  Search

Placesv X

= =
2 Desktop 02
[CIFile System

) Network

5. Rename the 01 folder to CD Image.

- Linux driver - File Browser - O x
File Edit View Go Bookmarks Tabs Help
=
€ . @* 2 & = [
Back up Reload Home  Computer  Search

H:z| ‘ < ||\ZIJENNY_BOOTHLinux dnver‘

Placesv X h
& asus |
3 Deskiop cdimage
[ File System
) Network
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Installing SUSE Linux 11 OS

To install the LSI MegaRAID controller driver when installing SUSE Linux Enterprise
Server OS:

Boot the system from the SUSE OS installation CD.
2. Use the arrow keys to select Installation from the Boot Options menu.

Boot from Hard Disk

Installation

Repair Installed System

Rescue System
Check Installation Media
Firmware Test

Memory Test

Boot Options

F1 Help F2 Language F3 video Mode F4 Source F5 Kernel F6 Driver
English (US) 800 x 600 DVD Default No

3. Press <F6>, then select Yes from the menu. Press <Enter>.

Boot from Hard Disk
Repair Installed System
Rescue System

Check Installation Media
Firmware Test

Memory Test

Boot Options

F1 Help F2 Language F3 Video Mode F4 Source F5 Kernel F6 Driver
English (US) 800 x 600 DVD Default No
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4. Use the USB drive to provide the third-party driver during the OS installation.

Type the command brokenmodules=ahci in Boot Options field, and press
<Enter>.

Boot from Hard Disk
Repair Installed System
Rescue System

Check Installation Media
Firmware Test

Memory Test

Boot Options brokenmodules=ahci

F1 Help F2 Language F3 Video Mode F4 Source F5 Kernel F6 Driver
English (US) 800 x 600 DVD Default Yes

5. When below screen appears, select the USB floppy disk drive (sda) as the
driver update medium. Select OK, then press <Enter>.

Please choose the Driver Update medium.

sda: USB Flopp

Other device

6.  Select Back and follow the onscreen instructions to finish the installation.

ASUS Z9NA-D6
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6.2 Intel® chipset device software

installation

This section provides the instructions on how to install the Intel® chipset device
software on the system.

You need to manually install the Intel® chipset device software on a Windows
operating system.

To install the Intel® chipset device software:

1.
2.

3.

4.

Restart the computer, and then log on with Administrator privileges.

Insert the motherboard/system support DVD to the optical drive. The support
DVD automatically displays the Drivers menu if Autorun is enabled in your
computer.

If Autorun is NOT enabled in your computer, browse the contents of the support
DVD to locate the file ASSETUP.EXE from the BIN folder. Double-click the
ASSETUP.EXE to run the support DVD.

Click the item Intel Chipset Device Software from the menu.

et CH00 Ser /&1 2006 A2 B4 bit

vvvvvv

The Intel(R) Chipset Device Software window appears. Click Next to start
installation.

Intel@® Chipset Device Software

Intel® Chipset Device Software

Welcome to the Setup Program

This setup program will instal the Intel@ Chipset Device Software onto this computer. Ttis
strongly recommendes that you exit all programs before continuing

< Back Next > Cancel

Intel@ Installation Framework
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5. Select Yes to accept the terms of the License Agreement and continue the
process.

tel® Chipset Device Software

License Agreement

You must accept all of the terms of the license agreement in order to continue the setup
program. Do you accept the terms?

INTEL SOFTWARE LICENSE AGREEMENT {OEM /IHV / ISV Distribution & Single User) il

IMPORTANT - READ BEFORE COPYING, INSTALLING CR USING.

Do not use or load this software and any assodated materials {colectively, the "Software™)
until you have carefully read the folowing terms and conditions. By loading or using the
Software, you agree to the terms of this Agreement. If you do not wish to so agree, do not
install or use the Software,

Please Also Note:

* If you are an Original Equipment Manufacturer (OEM), Independent Hardware Vendor
{IHV), or Independent Software Vendor (ISV), this complete LICENSE AGREEMENT applies;

=l

< Back Yes No |

Inkel@® Instalation Framework,

6. Read the Readme File Information and press Next to continue the
installation.

D Chipset Device Software i'nte[

Readme File Information

Refer to the Readme file below to view the system requirements and installation information
Press the Page Down key to view the rest of the fle.

m—uun~muuummuu~muuummuunmuuum—muil
* Product: Intel(R) Chipset Device Software

* Release: Production Version

* Version: 9.2.3.1023

* Target:

Intel (R) Xeon(R) Processor ES Product Fa
*

Intel (R) C600/X79 series chipset
* Date: November 11 2011

R R R R R R R R

N [ |

<Back Next > I Cancel |

Intel® Instalation Framework,

7. After completing the installation, click Next to complete the setup process.

tel® Chipset Device Software

) Chipset Device Software.
Setup Progress

Please wait whie the following setup operations are performed:

Installing Driver: Intel(R) C600/X73 series chipset SMBus Controller 0 - 1D70 |
Version: 9.2.3.

Instaling Driver: Intel(R) C800/X78 series chipset SMBus Host Controller - 1022

Version: 9.2.3.

Instaling Driver: Intel(R) C600/X79 series chipset USB2 Enhanced Host Controller #1- 1D26
Version: 9.2.3.

Instaling Driver: Intel(R) C600/X79 series chipset USB2 Enhanced Host Controller #2 - 1D2D
Version: 9.2.3.1013

Intel® Installation Framework
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8.

Select Yes, | want to restart my computer now and click Finish to restart

your computer before using the program.

et Device Software

Intel® Chipset Device Software

Setup Is Complete

You must restart this computer for the changes to take effect. Would you like to restart the
computer now?

¥ Yes, I want to restart this computer now.
" No, T will restart this computer later.

Click Finish, then remave any installstion media from the drives.

Intel@ Installation Framework
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6.3 Intel® Network Connections Software
installation

This section provides the instructions on how to install the Intel® Network
Connections Software on the system.

You need to manually install the Intel® Network Connections Software on a
Windows® operating system. To install the Intel® Network Connections Software:

1. Restart the computer, and then log on with Administrator privileges.

2. Insert the motherboard/system support DVD to the optical drive. The support
DVD automatically displays the Drivers menu if Autorun is enabled in your
computer.

+ Windows® automatically detects the LAN controllers and displays a New
a Hardware Found window. Click Cancel to close this window.

If Autorun is NOT enabled in your computer, browse the contents of the
support DVD to locate the file ASSETUP.EXE from the BIN folder. Double-
click the ASSETUP.EXE to run the DVD.

3. Click the Intel® Network Connections Software to begin installation.

(= “= ASUS Server CBO0 Sefies Support DYD - et 2008 A2 B4 bit

vers | Wites | MekeDik | Comsor |
: |
Drivers

J"f

4.
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5. Click Next when the Intel(R) Network Connections-InstallShield Wizard
window appears.

i Intel(R) Network Connections - InstallShield Wizard x
Welcome to the InstallShield Wizard for o
Intel(R) Network Connections (lntel

The Instalshield(R) Wizard will alow you to modify or remove
Intel(R) Netwark Connections. To continue, dick Next.

< Back I Next > I Cancel |

6. Select Modify and then click Next to continue.

1% Intel(R) Network Connections - InstallShield Wizard x

Program Maintenance

‘ Modify or remove the program.

‘ = Modify
@ Change which program features are installed. This option displays the

Custom Setup dialog in which you can change the way features are
installed.

" Remove

@ Remove Intel(R) Network Connections from your computer,

| Instalishield

< Back I Next > I Cancel

7. Click the Intel(R) PROSet for Windows Device Manager box, and then click
Next to start the installation.

Intel{R) Network Connections x|

Setup Options

Select the program features you want installed.

Install
Drivers
Intel(R) PROSsE for windows* Device Manager
H [ Advvanced Metwork Services
- CQInteliR) Mekwark Connections SHMP Agent

~Feature Description

< Back Cancel
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8.  Follow the screen instructions to complete installation.

1% Intel(R) Network Connections - InstallShield Wizard

Ready to Install the Program

The wizard Is ready to begin instalation

9.

11§ Intel{R) Network Connections - Installshield Wizard

InstallShield Wizard Completed

ASUS Z9NA-D6 6-21
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6.4 VGA driver installation

This section provides the instructions on how to install the ASPEED Video
Graphics Adapter (VGA) driver.

You need to manually install the ASPEED VGA driver on a Windows® operating
system.

To install the ASPEED VGA driver:

1.
2.

Restart the computer, and then log on with Administrator privileges.

Insert the motherboard/system support DVD to the optical drive. The support
DVD automatically displays the Drivers menu if Autorun is enabled in your
computer.

DVD to locate the file ASSETUP.EXE from the BIN folder. Double-click the

% If Autorun is NOT enabled in your computer, browse the contents of the support

ASSETUP.EXE to run the support DVD.

Click the ASPEED AST2300 Display Driver to begin installation.

= £ =2 ASUS Server C8O0 Series Suppart DVD - Windows Server 2008 RZE4 bit

| ites | ekeik | Comast |

Drivers

_Please select items on the
Vight side. 4

i

When the ASPEED Graphics installation wizard appears, click Next to start
the installation.

Welcome to the Installshield Wizard for
ASPEED Graphics WinS08R2_x64 v.0.93

The InstaliShield(R) Wizard will install ASPEED Graphics
WinS08R2_x64 v.0.8% on your computer. To continue, dick
Next.

WARNING: This program is protected by copyright law and
international treaties.

< Back. | Next > I Canicel
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5.

6.

7.

Toggle | accept the terms in the license agreement and click Next to

continue.

ASPEED Graphics WinS08R2_x64 v.0.93 - Instalishield wizard x|

License Agreement

Pleass read the following license agreement carefuly.

o add your own license text to this dislog, specify your licanse agreement file in the Dialog
editor.

Navigate to the User Interface view.

Select the LicenseAgreement dialog.

Choose to edit the dialog layout.

Once in the Dialog editor, select the Memo ScrollableText control.
Set Filelame to the name of your license agresment RTF file,

GECTS

After you build your release, your license text will be displayed in the License Agreement dialog.

£ Iaccept the terms in the license agreement Print

I do not accept the terme in the license agresment

< Back Next > Cancel |

Enter the user information and click Next to continue.
]

‘Customer Information

Please enter your information.

< Back Next > Cancel

Select a setup type and click Next to continue.

{1 ASPEED Graphics

inS08R2_x64 V.

InstallShield Wizard x|
Setup Type
Choose the setup type that best suits your needs.

Please select a setup type.

 Complete

All program features will be installed, (Requires the most disk
space.)

 Custom

Choose which program features you want installed and where they
will be installed. Recommended for advanced users,

<Back Next > Cancel

ASUS Z9NA-D6
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7.  Click Install to start driver installation.

i'_%la ASPEED Graphics WinS08R2_x64 v.0.93 - InstaliShield Wizard 5‘
Ready to Install the Program
The wizard is ready to begin installation.
Click Instal to begin the instalation.
If you want to review or ch ‘of your instalation settings, diick Back. Click Cancel to
exit the wizard.
InstalShicld
< Back Install Cancel

8.  When the installation completes, click Finish to restart your computer before
using the program.

{i& ASPEED Graphics WinS0BR2_x64 v.0.93 - InstallShield Wizard x|

InstallShield Wizard Completed

| The InstallShield Wizard has successfull installed ASPEED
Graphics WinS08R2_x64 v.0.93, Click Finish to exit the wizard,

ceeck [ Fmsh | ool |

i'-.a ASPEED Graphics WinS08R2_x64 v.0.93 Installer 5[

‘You must restart your system for the configuration
changes made to ASPEED Graphics WinS08R2_x64
v.0.93 to take effect. Click Yes to restart now or No if
you plan to restart later.

[ = 1 _% |
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6.5 Intel® C600 Series Chipset SCU SATA
RAID Drivers

This section provides the instructions on how to install the Intel® C600 Series
Chipset SCU SATA RAID Drivers on the system.

You need to manually install the Intel® C600 Series Chipset SCU SATA RAID
Drivers on a Windows operating system.

To install the drivers:

1. Restart the computer, and then log on with Administrator privileges.

2. Insert the motherboard/system support DVD to the optical drive. The support
DVD automatically displays the Drivers menu if Autorun is enabled in your
computer.

If Autorun is NOT enabled in your computer, browse the contents of the support
DVD to locate the file ASSETUP.EXE from the BIN folder. Double-click the
- ASSETUP.EXE to run the support DVD.

3.  Click the item Intel® C600 Series Chipset SCU SATA RAID Drivers from the
menu, and then follow the onscreen instructions to complete the installation.

' (= =l 45US Server CAOD Serizs Suppoit DVD - Windows Server 2008 A2 64 bit

| usites | bskeDisk | Coisst |

AsusSetup ﬂ

MName Intel(R) C600 Senes Chipset SCU SATA RAID Driver
Version 3.0.0.3014

Description Install Intel(R) C600 Series Chipset SCL SATA RAID
Driver.

ASUS Z9NA-D6
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6.6 Intel® Rapid Storage Technology

enterprise 3.0 installation

This section provides the instructions on how to install the Intel® Rapid Storage
Technology enterprise 3.0 on the system.

You need to manually install the Intel® Rapid Storage Technology enterprise 3.0
utility on a Windows® operating system.

To install the Intel® Rapid Storage Technology enterprise 3.0 utility:

Restart the computer, and then log on with Administrator privileges.

Insert the motherboard/system support DVD to the optical drive. The support
DVD automatically displays the Drivers menu if Autorun is enabled in your
computer.

DVD to locate the file ASSETUP.EXE from the BIN folder. Double-click the

% If Autorun is NOT enabled in your computer, browse the contents of the support

3.

4.

ASSETUP.EXE to run the support DVD.

Click the Intel® Rapid Storage Technology enterprise 3.0 to begin
installation.

(= =l ASUS Sewver CBO0 Series Support DVD - Wwin ver 2008 A2 B4 bit ]

vvvvvv | wies | MekeDuk | comsar |

When the Welcome to the Setup Program appears, click Next to start the
installation.

Intel® Installation Framework P[] 3|

Intel® Rapid Storaae Tex

Welcome to the Setup Program

This setup program wil instal Intel ® Rapid Storage Technology enterprise onto this computer.

Itis strongly recommended that you exit all programs before continuing. Click Next to continue.

< Back Next > I Cancel |

Intel® Instalation Framework,
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5. Read the Warning message and click Next to continue.

The Intel® Rapid Storage Technology enterprise driver you are about to install may be used to
control the hard drive that this computer boots from or to control a hard drive that contains
important data, Therefore, you wil not be able to uninstall this driver after instalation. However,
you will be able to uninstall the non-critical components of this software such as the User
Interface, Event Monitor Service, and program shortcuts,

| ClidNext to continue, or diic Cancel to exit the setup program

<Back Next > I Cancel

Intel@ Installation Framework

6. Read the License Agreement and click Yes to continue.

License Agreement

You must accept al of the terms of the license agreement in order to continue the setup
program. Do you accept the terms?

[INTEL SOFTWARE LICENSE AGREEMENT {OEM [ IHV {15V Distribution & Single User) :I

IMPORTANT - READ BEFORE COPYING, INSTALLING OR USING.

Do not use or load this software and any assodiated materials (collectively, the "Software”)
luntil you have carefully read the following terms and conditions. By loading or using the
Software, you agree to the terms of this Agreement. If you do not wish to so agree, do not
instal or use the Software.

Please Also Note:

* If you are an Criginal Equipment Manufacturer (GEM), Independent Hardware Vendor
|IHY), or Independent Software Vendor {I5V), this complete LICENSE AGREEMENT applies;
* If you are an End-User, then only Exhibit A, the INTEL SOFTWARE LICENSE AGREEMENT,

< Back ‘es | No I

Inkel® Installation Framework

7. Read the Readme File Information and click Next to continue.

Readme File Information

Refer to the Readme file below to view the system requirements and instalation information.

= Installation Readme for Intel(R) Rapid Storage
= Technology enterprise (Intel(R) RSTe).

* Refer to the system requirements for the operating
= systems supported by Intel(R) Rapid Storage Technology
= enterprise.

= This document makes references to products developed by

= Intel(R). There are some restrictions on how these products
= may be used, and what information may be disclosed to

< Back Next > I Cancel

Intel® Instalation Framework:

ASUS Z9NA-D6
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8.

After completing the installation, click Next to complete the setup process.

Please wait while the following setup operations are performed:

Copying Flle: C:

\Program Files Rapid Storage Technology enterprise \unins « |
rogram Files Rapid Storage Technology enterprise unins’

rogram Files Rapid Storage Technology enterprise\unins

rogram Files Rapid Storage Technology enterprise \unins

indows\Sy: \cificap,

Windows\system32\difapi.di

Click Next to continue. -
4

Intel@ Tnstallation Framework

Select Yes, | want to restart my computer now and click Finish to restart

your computer before using the program.

Rapid. Storage T

Setup Is Complete

You must restart this computer for the changes to take effect, Would you like to restart the
computer now?

@ Yes, T want to restart this computer now.
" ha, Twil restart this computer later,

Click Finish, then remove any installation media from the drives.

Inkel® Installation Framework.

Chapter 6: Driver installation



6.7 Intel® WG82574L Gigabit Adapters
Driver installation

This section provides the instructions on how to install Intel® 82574L Gigabit
Adapters Driver.

To install the Intel® WG82574L Gigabit Adapters Driver on a Windows® OS:

1. Restart the computer, and then log on with Administrator privileges.

2. Insert the motherboard/system support DVD to the optical drive. The DVD
automatically displays the Drivers menu if Autorun is enabled in your
computer.

If Autorun is NOT enabled in your computer, browse the contents of the support
DVD to locate the file AUTORUN.EXE and double-click the AUTORUN.EXE
— and follow step 4 to run the installation.

3. Click Intel® WG82574L Gigabit Adapters Driver.

Divers | Uities | MskeDisk | Gonisal |

Drivers

_Please selectitems on the
right side_

ASUS Z9NA-D6
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4. When the Intel® Network Connections - InstallShield Wizard window
appears, click Next to start the installation.
£

‘Welcome to the InstallShield Wizard for

Intel(R) Network Connections ‘ intel)

The InstallShield(R) Wizard will allow you to modify or remove
Intel(R) Network Connections. To continue, dick Next.

Installshield

< Back I Next > I Cancel

5. Select Modify and then click Next to continue.

i@ Intel(R) Network Connections - InstallShield Wizard x|

Program Maintenance

Modify or remove the program. ( intel

Change which program features are installed. This option displays the
@ Custom Setup dialog in which you can change the way features are
installed.

@ Remove Intel(R) Network Connections from your computer.

| Instalshield

< Back Next > Cancel
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6.

7.

Select the programs you want to install and click Next to continue.

Intel(R) Network Connections: |
Setup Options

Select the program features you want installed. t ]nt8|:

Install:

Intel(R) PROSet for Windows™® Device Manager
Advanced Nebwork Services
- ] Intel{R) Metwork Connections SNMP Agent

Feature Description
Drivers for all wired Intel Network Connections

< Back Next > Cancel

Click Install to start the installation.

{i Intel(R) Network Connections - InstallShield Wizard 1 x|

Ready to Install the Program

The wizard is ready to begin installation.

Click Install to begin the installation.

If you want to review or change any of your installation settings, dick Back. Click Cancel to
exit the wizard,

Instalishield

< Back Install Cancel

ASUS Z9NA-D6
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8.  The programs you select are being installed.

{& Intel(R) Nebwork Connections - InstallShield Wizard i =Ex]

Installing Intel{R) Network Connections

The program features you selected are being installed. (Inte!

A[d]  Please wait while the InstallShield Wizard installs Intel(R) Network
Connections. This may take several minutes.

Status:

e

Instalishisld

= Back hiext > | Gancel I

9.  Click Finish to finish the installation.

|§- Intel{R) Network Connections - InstallShield Wizard B x|

InstallShield Wizard Completed .

(intel.

To access new features, open Device Manager, and view the
properties of the network adapters.

Instafishield

= Back I Finish I Cance]

10. Restart your computer before using the program.

x

You must restart your computer to apply these changes

Before restarting, save any open files and dose all programs.

Restart Now I Restart Later
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6.8 Management applications and utilities
installation
The support DVD that came with the motherboard package contains the drivers,

management applications, and utilities that you can install to avail all motherboard
features.

The contents of the support DVD are subject to change at any time without
notice. Visit the ASUS website (www.asus.com) for updates.

6.8.1 Running the support DVD

Place the support DVD to the optical drive. The DVD automatically displays the
Drivers menu if Autorun is enabled in your computer.

If Autorun is NOT enabled in your computer, browse the contents of the support
DVD to locate the file ASSETUP.EXE from the BIN folder. Double-click the
— ASSETUP.EXE to run the support DVD.

6.8.2 Drivers menu

The Drivers menu shows the available device drivers if the system detects installed
devices. Install the necessary drivers to activate the devices.

The screen display and driver options vary under different operating system
versions.

== | ASLIS Server CHON Sefies Support DYD - Windows Server 2008 A2 64 bit

| oiiies | Makeisk | Gortaat |

Drivers

o)

" Please selectitems on the

ight side. e

-~
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6.8.3 Utilities menu

The Utilities menu displays the L
software applications and utilities 2= | = | e ||
that the motherboard supports.
Click an item to install.

6.8.4 Make disk menu

The Make disk menu contains :
items to create the Intel RAID e e
driver disks. disk

el Seiies Support DYD - Windows Server 2008

6.8.5 Contact information

Click the Contact tab to display ~ [E= s s a
the ASUS contact information. e
You can also find this information
on the inside front cover of this
user guide.
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This appendix includes additional
information that you may refer to when
configuring the motherboard.

Reference information
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A.1 Z9NA-D6 block diagram

-DRRS 1066/1333/1600 MHz

-DRH3 1066/1333/1600 MHz

| DDR3 & DDR3L RDIMMs & UDIMMs, LR DIMMs |

1066/1333/1600 MHz
HDRH(S
- Intel®Xeon

x16 G3

PCIET x16 Gen3 Link
-PIKE x4 Gen3 Link

x1G2
PCIE5

1066/1333/1600 MHz -
DRR3

1066/1333/1600 MHz -
DRR3

1066/1333/1 MH
066/1333/1600 MHz -DRH3

MIO card

Intel 82574L

Intel 82574L

AST2300

e

ASUS Z9NA-D6

Intel® Xeon
E5-2400 _ QPI E5-2400
G . x8 G3
x8 Gen3 Link -F’CIEZ
CPU1 CPU2 _ x8 G3
x8 Gen3 Link -PCIE3
x4 DMI2
1 Gen3 Link . x8 G2
x1 Gen3 Lin| x4 Gen3 Link -PCIE4
HD Aucio USE
Intel® usBHusB|HusB 9x USB1.1/USB
C602 2.0 Ports
x1
2 x SATA Il Port
PCH xS orts
x1 4 x SATA Il Ports
4 x SATA Il Ports
X LPC

TPM
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ASUS contact information

ASUSTeK COMPUTER INC. (Taiwan)

Address 15 Li-Te Road, Peitou, Taipei, Taiwan 11259
Telephone +886-2-2894-3447

Fax +886-2-2890-7798

E-mail info@asus.com.tw

Web site http://iwww.asus.com.tw

Technical Support

Telephone +886-2-2894-3447 (0800-093-456)

Online Support http://support.asus.com/techserv/techserv.aspx

ASUSTeK COMPUTER INC. (China)

Address No.508, Chundong Road, Xinzhuang Industrial Zone,
Minhang District, Shanghai, China.

Telephone +86-21-5442-1616

Fax +86-21-5442-0099

Web site http://www.asus.com.cn

Technical Support

Telephone +86-21-3407-4610 (800-820-6655)

Online Support http://support.asus.com/techserv/techserv.aspx

ASUS COMPUTER INTERNATIONAL (America)

Address 800 Corporate Way, Fremont, CA 94539, USA
Fax +1-510-608-4555

Web site http://usa.asus.com

Technical Support

Support fax +1-812-284-0883

General support +1-812-282-2787

Online support http://support.asus.com/techserv/techserv.aspx

ASUS COMPUTER GmbH (Germany and Austria)

Address Harkort Str. 21-23, D-40880 Ratingen, Germany
Fax +49-2102-959911

Web site http://www.asus.de

Online contact http://www.asus.de/sales

Technical Support

Telephone +49-1805-010923*

Support Fax +49-2102-959911

Online support http://support.asus.com/techserv/techserv.aspx

* EUR 0.14/minute from a German fixed landline; EUR 0.42/minute from a mobile phone.
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